IBM® SPSS® Statistics is a comprehensive system for analyzing data. The Decision Trees optional add-on module provides the additional analytic techniques described in this manual. The Decision Trees add-on module must be used with the SPSS Statistics Core system and is completely integrated into that system.

About SPSS Inc., an IBM Company

SPSS Inc., an IBM Company, is a leading global provider of predictive analytic software and solutions. The company’s complete portfolio of products — data collection, statistics, modeling and deployment — captures people’s attitudes and opinions, predicts outcomes of future customer interactions, and then acts on these insights by embedding analytics into business processes. SPSS Inc. solutions address interconnected business objectives across an entire organization by focusing on the convergence of analytics, IT architecture, and business processes. Commercial, government, and academic customers worldwide rely on SPSS Inc. technology as a competitive advantage in attracting, retaining, and growing customers, while reducing fraud and mitigating risk. SPSS Inc. was acquired by IBM in October 2009. For more information, visit http://www.spss.com.

Technical support

Technical support is available to maintenance customers. Customers may contact Technical Support for assistance in using SPSS Inc. products or for installation help for one of the supported hardware environments. To reach Technical Support, see the SPSS Inc. web site at http://support.spss.com or find your local office via the web site at http://support.spss.com/default.asp?refpage=contactus.asp. Be prepared to identify yourself, your organization, and your support agreement when requesting assistance.

Customer Service

If you have any questions concerning your shipment or account, contact your local office, listed on the Web site at http://www.spss.com/worldwide. Please have your serial number ready for identification.

Training Seminars

SPSS Inc. provides both public and onsite training seminars. All seminars feature hands-on workshops. Seminars will be offered in major cities on a regular basis. For more information on these seminars, contact your local office, listed on the Web site at http://www.spss.com/worldwide.
Additional Publications

The SPSS Statistics: Guide to Data Analysis, SPSS Statistics: Statistical Procedures Companion, and SPSS Statistics: Advanced Statistical Procedures Companion, written by Marija Norušis and published by Prentice Hall, are available as suggested supplemental material. These publications cover statistical procedures in the SPSS Statistics Base module, Advanced Statistics module and Regression module. Whether you are just getting starting in data analysis or are ready for advanced applications, these books will help you make best use of the capabilities found within the IBM® SPSS® Statistics offering. For additional information including publication contents and sample chapters, please see the author’s website: http://www.norusis.com
Part I: User’s Guide

1 Creating Decision Trees

Selecting Categories .......................................................... 6
Validation ................................................................... 7
Tree-Growing Criteria .......................................................... 8
  Growth Limits ............................................................ 9
  CHAID Criteria .......................................................... 10
  CRT Criteria .......................................................... 12
  QUEST Criteria ....................................................... 13
Pruning Trees ............................................................ 14
Surrogates .................................................................. 15
Options ..................................................................... 15
  Misclassification Costs .................................................... 16
  Profits ........................................................................ 17
  Prior Probabilities .......................................................... 18
Scores ......................................................................... 20
Missing Values ............................................................. 21
Saving Model Information ....................................................... 22
Output ........................................................................ 23
  Tree Display .............................................................. 24
Statistics ..................................................................... 26
Charts ........................................................................ 29
Selection and Scoring Rules ......................................................... 35

2 Tree Editor

Working with Large Trees .......................................................... 38
Tree Map ........................................................................ 39
Scaling the Tree Display .......................................................... 39
Node Summary Window .......................................................... 40
Controlling Information Displayed in the Tree ........................................ 41
Changing Tree Colors and Text Fonts ........................................ 42
Case Selection and Scoring Rules ................................................ 44
Filtering Cases ........................................................................ 44
Saving Selection and Scoring Rules ........................................... 45

**Part II: Examples**

3 **Data assumptions and requirements** ............................................ 48

Effects of measurement level on tree models .................................. 48
  Permanently assigning measurement level .................................... 51
  Variables with an unknown measurement level ......................... 52
Effects of value labels on tree models .......................................... 52
  Assigning value labels to all values ........................................ 54

4 **Using Decision Trees to Evaluate Credit Risk** ......................... 55

Creating the Model ...................................................................... 55
  Building the CHAID Tree Model .............................................. 55
  Selecting Target Categories .................................................. 56
  Specifying Tree Growing Criteria ......................................... 57
  Selecting Additional Output .................................................. 58
  Saving Predicted Values ....................................................... 60
Evaluating the Model .................................................................... 61
  Model Summary Table .......................................................... 62
  Tree Diagram ........................................................................ 63
  Tree Table ............................................................................ 64
  Gains for Nodes ..................................................................... 65
  Gains Chart ........................................................................... 66
  Index Chart ............................................................................ 66
  Risk Estimate and Classification .............................................. 67
  Predicted Values ..................................................................... 68
Refining the Model ....................................................................... 69
  Selecting Cases in Nodes ........................................................ 69
  Examining the Selected Cases ................................................. 70
  Assigning Costs to Outcomes .................................................. 72
Summary ...................................................................................... 76
5  Building a Scoring Model  

Building the Model .......................................................... 77
Evaluating the Model ......................................................... 78
  Model Summary ............................................................. 79
  Tree Model Diagram ...................................................... 80
  Risk Estimate .............................................................. 81
Applying the Model to Another Data File ................................ 82
Summary ........................................................................... 85

6  Missing Values in Tree Models  

Missing Values with CHAID .................................................. 87
CHAID Results ..................................................................... 89
Missing Values with CRT ...................................................... 90
CRT Results ......................................................................... 93
Summary ........................................................................... 95

Appendices

A  Sample Files  

B  Notices  

Index
Part I:
User’s Guide
Creating Decision Trees

The Decision Tree procedure creates a tree-based classification model. It classifies cases into groups or predicts values of a dependent (target) variable based on values of independent (predictor) variables. The procedure provides validation tools for exploratory and confirmatory classification analysis.

The procedure can be used for:

**Segmentation.** Identify persons who are likely to be members of a particular group.

**Stratification.** Assign cases into one of several categories, such as high-, medium-, and low-risk groups.

**Prediction.** Create rules and use them to predict future events, such as the likelihood that someone will default on a loan or the potential resale value of a vehicle or home.
**Data reduction and variable screening.** Select a useful subset of predictors from a large set of variables for use in building a formal parametric model.

**Interaction identification.** Identify relationships that pertain only to specific subgroups and specify these in a formal parametric model.

**Category merging and discretizing continuous variables.** Recode group predictor categories and continuous variables with minimal loss of information.

**Example.** A bank wants to categorize credit applicants according to whether or not they represent a reasonable credit risk. Based on various factors, including the known credit ratings of past customers, you can build a model to predict if future customers are likely to default on their loans.

A tree-based analysis provides some attractive features:
- It allows you to identify homogeneous groups with high or low risk.
- It makes it easy to construct rules for making predictions about individual cases.

**Data Considerations**

**Data.** The dependent and independent variables can be:
- **Nominal.** A variable can be treated as nominal when its values represent categories with no intrinsic ranking (for example, the department of the company in which an employee works). Examples of nominal variables include region, zip code, and religious affiliation.
- **Ordinal.** A variable can be treated as ordinal when its values represent categories with some intrinsic ranking (for example, levels of service satisfaction from highly dissatisfied to highly satisfied). Examples of ordinal variables include attitude scores representing degree of satisfaction or confidence and preference rating scores.
- **Scale.** A variable can be treated as scale (continuous) when its values represent ordered categories with a meaningful metric, so that distance comparisons between values are appropriate. Examples of scale variables include age in years and income in thousands of dollars.

**Frequency weights** If weighting is in effect, fractional weights are rounded to the closest integer; so, cases with a weight value of less than 0.5 are assigned a weight of 0 and are therefore excluded from the analysis.

**Assumptions.** This procedure assumes that the appropriate measurement level has been assigned to all analysis variables, and some features assume that all values of the dependent variable included in the analysis have defined value labels.
- **Measurement level.** Measurement level affects the tree computations; so, all variables should be assigned the appropriate measurement level. By default, numeric variables are assumed to be scale and string variables are assumed to be nominal, which may not accurately reflect
Creating Decision Trees

the true measurement level. An icon next to each variable in the variable list identifies the variable type.

- Scale
- Nominal
- Ordinal

You can temporarily change the measurement level for a variable by right-clicking the variable in the source variable list and selecting a measurement level from the context menu.

- **Value labels.** The dialog box interface for this procedure assumes that either all nonmissing values of a categorical (nominal, ordinal) dependent variable have defined value labels or none of them do. Some features are not available unless at least two nonmissing values of the categorical dependent variable have value labels. If at least two nonmissing values have defined value labels, any cases with other values that do not have value labels will be excluded from the analysis.

**To Obtain Decision Trees**

- From the menus choose:
  Analyze > Classify > Tree...

**Figure 1-2**

*Decision Tree dialog box*

- Select a dependent variable.
Select one or more independent variables.

Select a growing method.

Optionally, you can:
- Change the measurement level for any variable in the source list.
- Force the first variable in the independent variables list into the model as the first split variable.
- Select an influence variable that defines how much influence a case has on the tree-growing process. Cases with lower influence values have less influence; cases with higher values have more. Influence variable values must be positive.
- Validate the tree.
- Customize the tree-growing criteria.
- Save terminal node numbers, predicted values, and predicted probabilities as variables.
- Save the model in XML (PMML) format.

**Fields with Unknown Measurement Level**

The Measurement Level alert is displayed when the measurement level for one or more variables (fields) in the dataset is unknown. Since measurement level affects the computation of results for this procedure, all variables must have a defined measurement level.

![Measurement level alert](image)

- **Scan Data.** Reads the data in the active dataset and assigns default measurement level to any fields with a currently unknown measurement level. If the dataset is large, that may take some time.
- **Assign Manually.** Opens a dialog that lists all fields with an unknown measurement level. You can use this dialog to assign measurement level to those fields. You can also assign measurement level in Variable View of the Data Editor.

Since measurement level is important for this procedure, you cannot access the dialog to run this procedure until all fields have a defined measurement level.

**Changing Measurement Level**

- Right-click the variable in the source list.
Creating Decision Trees

Select a measurement level from the pop-up context menu. This changes the measurement level temporarily for use in the Decision Tree procedure.

**Growing Methods**

The available growing methods are:

**CHAID.** Chi-squared Automatic Interaction Detection. At each step, CHAID chooses the independent (predictor) variable that has the strongest interaction with the dependent variable. Categories of each predictor are merged if they are not significantly different with respect to the dependent variable.

**Exhaustive CHAID.** A modification of CHAID that examines all possible splits for each predictor.

**CRT.** Classification and Regression Trees. CRT splits the data into segments that are as homogeneous as possible with respect to the dependent variable. A terminal node in which all cases have the same value for the dependent variable is a homogeneous, "pure" node.

**QUEST.** Quick, Unbiased, Efficient Statistical Tree. A method that is fast and avoids other methods’ bias in favor of predictors with many categories. QUEST can be specified only if the dependent variable is nominal.

There are benefits and limitations with each method, including:

<table>
<thead>
<tr>
<th></th>
<th>CHAID*</th>
<th>CRT</th>
<th>QUEST</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chi-square-based**</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Surrogate independent (predictor) variables</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Tree pruning</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Multiway node splitting</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Binary node splitting</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Influence variables</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prior probabilities</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Misclassification costs</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Fast calculation</td>
<td>X</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Includes Exhaustive CHAID.

**QUEST also uses a chi-square measure for nominal independent variables.
Selecting Categories

For categorical (nominal, ordinal) dependent variables, you can:
- Control which categories are included in the analysis.
- Identify the target categories of interest.

Including/Excluding Categories

You can limit the analysis to specific categories of the dependent variable.
- Cases with values of the dependent variable in the Exclude list are not included in the analysis.
- For nominal dependent variables, you can also include user-missing categories in the analysis. (By default, user-missing categories are displayed in the Exclude list.)

Target Categories

Selected (checked) categories are treated as the categories of primary interest in the analysis. For example, if you are primarily interested in identifying those individuals most likely to default on a loan, you might select the “bad” credit-rating category as the target category.
- There is no default target category. If no category is selected, some classification rule options and gains-related output are not available.
- If multiple categories are selected, separate gains tables and charts are produced for each target category.
- Designating one or more categories as target categories has no effect on the tree model, risk estimate, or misclassification results.
Creating Decision Trees

**Categories and Value Labels**

This dialog box requires defined value labels for the dependent variable. It is not available unless at least two values of the categorical dependent variable have defined value labels.

**To Include/Exclude Categories and Select Target Categories**

- In the main Decision Tree dialog box, select a categorical (nominal, ordinal) dependent variable with two or more defined value labels.
- Click Categories.

**Validation**

Figure 1-5

Validation dialog box

Validation allows you to assess how well your tree structure generalizes to a larger population. Two validation methods are available: crossvalidation and split-sample validation.

**Crossvalidation**

Crossvalidation divides the sample into a number of subsamples, or **folds**. Tree models are then generated, excluding the data from each subsample in turn. The first tree is based on all of the cases except those in the first sample fold, the second tree is based on all of the cases except those
in the second sample fold, and so on. For each tree, misclassification risk is estimated by applying the tree to the subsample excluded in generating it.

- You can specify a maximum of 25 sample folds. The higher the value, the fewer the number of cases excluded for each tree model.
- Crossvalidation produces a single, final tree model. The crossvalidated risk estimate for the final tree is calculated as the average of the risks for all of the trees.

**Split-Sample Validation**

With split-sample validation, the model is generated using a training sample and tested on a hold-out sample.

- You can specify a training sample size, expressed as a percentage of the total sample size, or a variable that splits the sample into training and testing samples.
- If you use a variable to define training and testing samples, cases with a value of 1 for the variable are assigned to the training sample, and all other cases are assigned to the testing sample. The variable cannot be the dependent variable, weight variable, influence variable, or a forced independent variable.
- You can display results for both the training and testing samples or just the testing sample.
- Split-sample validation should be used with caution on small data files (data files with a small number of cases). Small training sample sizes may yield poor models, since there may not be enough cases in some categories to adequately grow the tree.

**Tree-Growing Criteria**

The available growing criteria may depend on the growing method, level of measurement of the dependent variable, or a combination of the two.
**Growth Limits**

Figure 1-6  
*Criteria dialog box, Growth Limits tab*

The Growth Limits tab allows you to limit the number of levels in the tree and control the minimum number of cases for parent and child nodes.

**Maximum Tree Depth.** Controls the maximum number of levels of growth beneath the root node. The Automatic setting limits the tree to three levels beneath the root node for the CHAID and Exhaustive CHAID methods and five levels for the CRT and QUEST methods.

**Minimum Number of Cases.** Controls the minimum numbers of cases for nodes. Nodes that do not satisfy these criteria will not be split.

- Increasing the minimum values tends to produce trees with fewer nodes.
- Decreasing the minimum values produces trees with more nodes.

For data files with a small number of cases, the default values of 100 cases for parent nodes and 50 cases for child nodes may sometimes result in trees with no nodes below the root node; in this case, lowering the minimum values may produce more useful results.
For the CHAID and Exhaustive CHAID methods, you can control:

**Significance Level.** You can control the significance value for splitting nodes and merging categories. For both criteria, the default significance level is 0.05.

- For splitting nodes, the value must be greater than 0 and less than 1. Lower values tend to produce trees with fewer nodes.
- For merging categories, the value must be greater than 0 and less than or equal to 1. To prevent merging of categories, specify a value of 1. For a scale independent variable, this means that the number of categories for the variable in the final tree is the specified number of intervals (the default is 10). For more information, see the topic Scale Intervals for CHAID Analysis on p. 11.

**Chi-Square Statistic.** For ordinal dependent variables, chi-square for determining node splitting and category merging is calculated using the likelihood-ratio method. For nominal dependent variables, you can select the method:

- **Pearson.** This method provides faster calculations but should be used with caution on small samples. This is the default method.
- **Likelihood ratio.** This method is more robust that Pearson but takes longer to calculate. For small samples, this is the preferred method.
Model Estimation. For nominal and ordinal dependent variables, you can specify:

- **Maximum number of iterations.** The default is 100. If the tree stops growing because the maximum number of iterations has been reached, you may want to increase the maximum or change one or more of the other criteria that control tree growth.

- **Minimum change in expected cell frequencies.** The value must be greater than 0 and less than 1. The default is 0.05. Lower values tend to produce trees with fewer nodes.

Adjust significance values using Bonferroni method. For multiple comparisons, significance values for merging and splitting criteria are adjusted using the Bonferroni method. This is the default.

Allow resplitting of merged categories within a node. Unless you explicitly prevent category merging, the procedure will attempt to merge independent (predictor) variable categories together to produce the simplest tree that describes the model. This option allows the procedure to resplit merged categories if that provides a better solution.

**Scale Intervals for CHAID Analysis**

In CHAID analysis, scale independent (predictor) variables are always banded into discrete groups (for example, 0–10, 11–20, 21–30, etc.) prior to analysis. You can control the initial/maximum number of groups (although the procedure may merge contiguous groups after the initial split):

- **Fixed number.** All scale independent variables are initially banded into the same number of groups. The default is 10.

- **Custom.** Each scale independent variable is initially banded into the number of groups specified for that variable.
To Specify Intervals for Scale Independent Variables

- In the main Decision Tree dialog box, select one or more scale independent variables.
- For the growing method, select CHAID or Exhaustive CHAID.
- Click Criteria.
- Click the Intervals tab.

In CRT and QUEST analysis, all splits are binary and scale and ordinal independent variables are handled the same way; so, you cannot specify a number of intervals for scale independent variables.

CRT Criteria

Figure 1-9
Criteria dialog box, CRT tab

The CRT growing method attempts to maximize within-node homogeneity. The extent to which a node does not represent a homogenous subset of cases is an indication of impurity. For example, a terminal node in which all cases have the same value for the dependent variable is a homogenous node that requires no further splitting because it is "pure.”

You can select the method used to measure impurity and the minimum decrease in impurity required to split nodes.

Impurity Measure. For scale dependent variables, the least-squared deviation (LSD) measure of impurity is used. It is computed as the within-node variance, adjusted for any frequency weights or influence values.
For categorical (nominal, ordinal) dependent variables, you can select the impurity measure:

- **Gini.** Splits are found that maximize the homogeneity of child nodes with respect to the value of the dependent variable. Gini is based on squared probabilities of membership for each category of the dependent variable. It reaches its minimum (zero) when all cases in a node fall into a single category. This is the default measure.

- **Twoing.** Categories of the dependent variable are grouped into two subclasses. Splits are found that best separate the two groups.

- **Ordered twoing.** Similar to twoing except that only adjacent categories can be grouped. This measure is available only for ordinal dependent variables.

**Minimum change in improvement.** This is the minimum decrease in impurity required to split a node. The default is 0.0001. Higher values tend to produce trees with fewer nodes.

**QUEST Criteria**

Figure 1-10
Criteria dialog box, QUEST tab

For the QUEST method, you can specify the significance level for splitting nodes. An independent variable cannot be used to split nodes unless the significance level is less than or equal to the specified value. The value must be greater than 0 and less than 1. The default is 0.05. Smaller values will tend to exclude more independent variables from the final model.

**To Specify QUEST Criteria**

- In the main Decision Tree dialog box, select a nominal dependent variable.

- For the growing method, select QUEST.

- Click Criteria.
Chapter 1

- Click the QUEST tab.

**Pruning Trees**

**Figure 1-11**
Criteria dialog box, Pruning tab

With the CRT and QUEST methods, you can avoid overfitting the model by **pruning** the tree: the tree is grown until stopping criteria are met, and then it is trimmed automatically to the smallest subtree based on the specified maximum difference in risk. The risk value is expressed in standard errors. The default is 1. The value must be non-negative. To obtain the subtree with the minimum risk, specify 0.

**Pruning versus Hiding Nodes**

When you create a pruned tree, any nodes pruned from the tree are not available in the final tree. You can interactively hide and show selected child nodes in the final tree, but you cannot show nodes that were pruned in the tree creation process. For more information, see the topic Tree Editor in Chapter 2 on p. 37.
**Surrogates**

CRT and QUEST can use *surrogates* for independent (predictor) variables. For cases in which the value for that variable is missing, other independent variables having high associations with the original variable are used for classification. These alternative predictors are called surrogates. You can specify the maximum number of surrogates to use in the model.

- By default, the maximum number of surrogates is one less than the number of independent variables. In other words, for each independent variable, all other independent variables may be used as surrogates.
- If you don’t want the model to use surrogates, specify 0 for the number of surrogates.

**Options**

Available options may depend on the growing method, the level of measurement of the dependent variable, and/or the existence of defined value labels for values of the dependent variable.
Chapter 1

**Misclassification Costs**

For categorical (nominal, ordinal) dependent variables, misclassification costs allow you to include information about the relative penalty associated with incorrect classification. For example:

- The cost of denying credit to a creditworthy customer is likely to be different from the cost of extending credit to a customer who then defaults on the loan.
- The cost of misclassifying an individual with a high risk of heart disease as low risk is probably much higher than the cost of misclassifying a low-risk individual as high-risk.
- The cost of sending a mass mailing to someone who isn’t likely to respond is probably fairly low, while the cost of not sending the mailing to someone who is likely to respond is relatively higher (in terms of lost revenue).

**Misclassification Costs and Value Labels**

This dialog box is not available unless at least two values of the categorical dependent variable have defined value labels.

**To Specify Misclassification Costs**

- In the main Decision Tree dialog box, select a categorical (nominal, ordinal) dependent variable with two or more defined value labels.
- Click Options.
- Click the Misclassification Costs tab.
- Click Custom.
Enter one or more misclassification costs in the grid. Values must be non-negative. (Correct classifications, represented on the diagonal, are always 0.)

**Fill Matrix.** In many instances, you may want costs to be symmetric—that is, the cost of misclassifying A as B is the same as the cost of misclassifying B as A. The following controls can make it easier to specify a symmetric cost matrix:

- **Duplicate Lower Triangle.** Copies values in the lower triangle of the matrix (below the diagonal) into the corresponding upper-triangular cells.

- **Duplicate Upper Triangle.** Copies values in the upper triangle of the matrix (above the diagonal) into the corresponding lower-triangular cells.

- **Use Average Cell Values.** For each cell in each half of the matrix, the two values (upper- and lower-triangular) are averaged and the average replaces both values. For example, if the cost of misclassifying A as B is 1 and the cost of misclassifying B as A is 3, then this control replaces both of those values with the average \((1+3)/2 = 2\).

**Profits**

For categorical dependent variables, you can assign revenue and expense values to levels of the dependent variable.

- Profit is computed as revenue minus expense.

- Profit values affect average profit and ROI (return on investment) values in gains tables. They do not affect the basic tree model structure.

- Revenue and expense values must be numeric and must be specified for all categories of the dependent variable displayed in the grid.
**Profits and Value Labels**

This dialog box requires defined value labels for the dependent variable. It is not available unless at least two values of the categorical dependent variable have defined value labels.

**To Specify Profits**

- In the main Decision Tree dialog box, select a categorical (nominal, ordinal) dependent variable with two or more defined value labels.
- Click Options.
- Click the Profits tab.
- Click Custom.
- Enter revenue and expense values for all dependent variable categories listed in the grid.

**Prior Probabilities**

For CRT and QUEST trees with categorical dependent variables, you can specify prior probabilities of group membership. **Prior probabilities** are estimates of the overall relative frequency for each category of the dependent variable prior to knowing anything about the values of the independent (predictor) variables. Using prior probabilities helps to correct any tree growth caused by data in the sample that is not representative of the entire population.
Obtain from training sample (empirical priors). Use this setting if the distribution of dependent variable values in the data file is representative of the population distribution. If you are using split-sample validation, the distribution of cases in the training sample is used.

Note: Since cases are randomly assigned to the training sample in split-sample validation, you won’t know the actual distribution of cases in the training sample in advance. For more information, see the topic Validation on p. 7.

Equal across categories. Use this setting if categories of the dependent variable are represented equally in the population. For example, if there are four categories, approximately 25% of the cases are in each category.

Custom. Enter a non-negative value for each category of the dependent variable listed in the grid. The values can be proportions, percentages, frequency counts, or any other values that represent the distribution of values across categories.

Adjust priors using misclassification costs. If you define custom misclassification costs, you can adjust prior probabilities based on those costs. For more information, see the topic Misclassification Costs on p. 16.

Profits and Value Labels

This dialog box requires defined value labels for the dependent variable. It is not available unless at least two values of the categorical dependent variable have defined value labels.

To Specify Prior Probabilities

- In the main Decision Tree dialog box, select a categorical (nominal, ordinal) dependent variable with two or more defined value labels.
- For the growing method, select CRT or QUEST.
- Click Options.
- Click the Prior Probabilities tab.
For CHAID and Exhaustive CHAID with an ordinal dependent variable, you can assign custom scores to each category of the dependent variable. Scores define the order of and distance between categories of the dependent variable. You can use scores to increase or decrease the relative distance between ordinal values or to change the order of the values.

- **Use ordinal rank for each category.** The lowest category of the dependent variable is assigned a score of 1, the next highest category is assigned a score of 2, and so on. This is the default.
- **Custom.** Enter a numeric score value for each category of the dependent variable listed in the grid.

### Example

<table>
<thead>
<tr>
<th>Value Label</th>
<th>Original Value</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unskilled</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Skilled manual</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>Clerical</td>
<td>3</td>
<td>4.5</td>
</tr>
<tr>
<td>Professional</td>
<td>4</td>
<td>7</td>
</tr>
<tr>
<td>Management</td>
<td>5</td>
<td>6</td>
</tr>
</tbody>
</table>

- The scores increase the relative distance between *Unskilled* and *Skilled manual* and decrease the relative distance between *Skilled manual* and *Clerical*.
- The scores reverse the order of *Management* and *Professional*. 
Creating Decision Trees

Scores and Value Labels

This dialog box requires defined value labels for the dependent variable. It is not available unless at least two values of the categorical dependent variable have defined value labels.

To Specify Scores

- In the main Decision Tree dialog box, select an ordinal dependent variable with two or more defined value labels.
- For the growing method, select CHAID or Exhaustive CHAID.
- Click Options.
- Click the Scores tab.

Missing Values

The Missing Values tab controls the handling of nominal, user-missing, independent (predictor) variable values.

- Handling of ordinal and scale user-missing independent variable values varies between growing methods.
- Handling of nominal dependent variables is specified in the Categories dialog box. For more information, see the topic Selecting Categories on p. 6.
- For ordinal and scale dependent variables, cases with system-missing or user-missing dependent variable values are always excluded.
Chapter 1

Treat as missing values. User-missing values are treated like system-missing values. The handling of system-missing values varies between growing methods.

Treat as valid values. User-missing values of nominal independent variables are treated as ordinary values in tree growing and classification.

Method-Dependent Rules

If some, but not all, independent variable values are system- or user-missing:

- For CHAID and Exhaustive CHAID, system- and user-missing independent variable values are included in the analysis as a single, combined category. For scale and ordinal independent variables, the algorithms first generate categories using valid values and then decide whether to merge the missing category with its most similar (valid) category or keep it as a separate category.
- For CRT and QUEST, cases with missing independent variable values are excluded from the tree-growing process but are classified using surrogates if surrogates are included in the method. If nominal user-missing values are treated as missing, they are also handled in this manner. For more information, see the topic Surrogates on p. 15.

To Specify Nominal, Independent User-Missing Treatment

- In the main Decision Tree dialog box, select at least one nominal independent variable.
- Click Options.
- Click the Missing Values tab.

Saving Model Information

Figure 1-18
Save dialog box
You can save information from the model as variables in the working data file, and you can also save the entire model in XML (PMML) format to an external file.

**Saved Variables**

**Terminal node number.** The terminal node to which each case is assigned. The value is the tree node number.

**Predicted value.** The class (group) or value for the dependent variable predicted by the model.

**Predicted probabilities.** The probability associated with the model’s prediction. One variable is saved for each category of the dependent variable. Not available for scale dependent variables.

**Sample assignment (training/testing).** For split-sample validation, this variable indicates whether a case was used in the training or testing sample. The value is 1 for the training sample and 0 for the testing sample. Not available unless you have selected split-sample validation. For more information, see the topic Validation on p. 7.

**Export Tree Model as XML**

You can save the entire tree model in XML (PMML) format. You can use this model file to apply the model information to other data files for scoring purposes.

**Training sample.** Writes the model to the specified file. For split-sample validated trees, this is the model for the training sample.

**Test sample.** Writes the model for the test sample to the specified file. Not available unless you have selected split-sample validation.

**Output**

Available output options depend on the growing method, the measurement level of the dependent variable, and other settings.
You can control the initial appearance of the tree or completely suppress the tree display.

**Tree.** By default, the tree diagram is included in the output displayed in the Viewer. Deselect (uncheck) this option to exclude the tree diagram from the output.

**Display.** These options control the initial appearance of the tree diagram in the Viewer. All of these attributes can also be modified by editing the generated tree.

- **Orientation.** The tree can be displayed top down with the root node at the top, left to right, or right to left.
- **Node contents.** Nodes can display tables, charts, or both. For categorical dependent variables, tables display frequency counts and percentages, and the charts are bar charts. For scale dependent variables, tables display means, standard deviations, number of cases, and predicted values, and the charts are histograms.
- **Scale.** By default, large trees are automatically scaled down in an attempt to fit the tree on the page. You can specify a custom scale percentage of up to 200%.
- **Independent variable statistics.** For CHAID and Exhaustive CHAID, statistics include $F$ value (for scale dependent variables) or chi-square value (for categorical dependent variables) as well as significance value and degrees of freedom. For CRT, the improvement value is shown. For QUEST, $F$, significance value, and degrees of freedom are shown for scale and
Creating Decision Trees

ordinal independent variables; for nominal independent variables, chi-square, significance value, and degrees of freedom are shown.

- **Node definitions.** Node definitions display the value(s) of the independent variable used at each node split.

**Tree in table format.** Summary information for each node in the tree, including parent node number, independent variable statistics, independent variable value(s) for the node, mean and standard deviation for scale dependent variables, or counts and percentages for categorical dependent variables.

**Figure 1-20**

*Tree in table format*

<table>
<thead>
<tr>
<th>Node</th>
<th>Parent Node</th>
<th>Predicted Category</th>
<th>Primary Independent Variable</th>
<th>N</th>
<th>Percent</th>
<th>N</th>
<th>Percent</th>
<th>N</th>
<th>Percent</th>
<th>Sig.</th>
<th>Chi-Square</th>
<th>df</th>
<th>Split Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td>Good</td>
<td>Income level</td>
<td>1020</td>
<td>41.4%</td>
<td>1144</td>
<td>50.6%</td>
<td>2464</td>
<td>100.0%</td>
<td></td>
<td>0.052</td>
<td>2</td>
<td>&lt;= Low</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>Good</td>
<td>Income level</td>
<td>454</td>
<td>17.8%</td>
<td>99</td>
<td>4.2%</td>
<td>553</td>
<td>22.4%</td>
<td>662.457</td>
<td>2</td>
<td>&lt;= Low</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>Good</td>
<td>Income level</td>
<td>470</td>
<td>18.9%</td>
<td>650</td>
<td>28.0%</td>
<td>1124</td>
<td>40.9%</td>
<td>662.457</td>
<td>2</td>
<td>&lt;= Low</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Good</td>
<td>Income level</td>
<td>90</td>
<td>3.5%</td>
<td>667</td>
<td>28.9%</td>
<td>777</td>
<td>31.5%</td>
<td>662.457</td>
<td>2</td>
<td>Low-Med</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>Good</td>
<td>Number of credit cards</td>
<td>422</td>
<td>16.9%</td>
<td>522</td>
<td>22.8%</td>
<td>744</td>
<td>30.2%</td>
<td>193.113</td>
<td>1</td>
<td>&lt;= 5</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>0</td>
<td>Good</td>
<td>Number of credit cards</td>
<td>54</td>
<td>2.1%</td>
<td>536</td>
<td>23.5%</td>
<td>590</td>
<td>19.4%</td>
<td>193.113</td>
<td>1</td>
<td>&lt;= 5</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>0</td>
<td>Good</td>
<td>Number of credit cards</td>
<td>90</td>
<td>3.5%</td>
<td>375</td>
<td>16.6%</td>
<td>455</td>
<td>16.5%</td>
<td>30.887</td>
<td>1</td>
<td>&lt;= 5</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>0</td>
<td>Good</td>
<td>Number of credit cards</td>
<td>10</td>
<td>0.4%</td>
<td>312</td>
<td>13.9%</td>
<td>322</td>
<td>12.7%</td>
<td>30.887</td>
<td>1</td>
<td>&lt;= 5</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>4</td>
<td>Good</td>
<td>Age</td>
<td>221</td>
<td>8.8%</td>
<td>59</td>
<td>2.6%</td>
<td>261</td>
<td>10.7%</td>
<td>95.299</td>
<td>1</td>
<td>&lt;= 25.079</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>4</td>
<td>Good</td>
<td>Age</td>
<td>221</td>
<td>8.8%</td>
<td>272</td>
<td>12.3%</td>
<td>483</td>
<td>18.0%</td>
<td>95.299</td>
<td>1</td>
<td>&gt; 25.079</td>
<td></td>
</tr>
</tbody>
</table>
Available statistics tables depend on the measurement level of the dependent variable, the growing method, and other settings.

**Model**

**Summary.** The summary includes the method used, the variables included in the model, and the variables specified but not included in the model.
**Risk.** Risk estimate and its standard error. A measure of the tree’s predictive accuracy.
- For categorical dependent variables, the risk estimate is the proportion of cases incorrectly classified after adjustment for prior probabilities and misclassification costs.
- For scale dependent variables, the risk estimate is within-node variance.

**Classification table.** For categorical (nominal, ordinal) dependent variables, this table shows the number of cases classified correctly and incorrectly for each category of the dependent variable. Not available for scale dependent variables.

**Figure 1-23**
*Risk and classification tables*

<table>
<thead>
<tr>
<th></th>
<th>Estimate</th>
<th>Std Error</th>
<th>Growing Method</th>
<th>CHAID</th>
<th>Dependent Variable: Credit rating</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Risk</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>255</td>
<td>0.08</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Observed</th>
<th>Predicted</th>
<th>Growing Method</th>
<th>CHAID</th>
<th>Dependent Variable: Credit rating</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Classification</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Cost, prior probability, score, and profit values.** For categorical dependent variables, this table shows the cost, prior probability, score, and profit values used in the analysis. Not available for scale dependent variables.

**Independent Variables**

**Importance to model.** For the CRT growing method, ranks each independent (predictor) variable according to its importance to the model. Not available for QUEST or CHAID methods.

**Surrogates by split.** For the CRT and QUEST growing methods, if the model includes surrogates, lists surrogates for each split in the tree. Not available for CHAID methods. For more information, see the topic Surrogates on p. 15.

**Node Performance**

**Summary.** For scale dependent variables, the table includes the node number, the number of cases, and the mean value of the dependent variable. For categorical dependent variables with defined profits, the table includes the node number, the number of cases, the average profit, and the ROI (return on investment) values. Not available for categorical dependent variables without defined profits. For more information, see the topic Profits on p. 17.
Chapter 1

Figure 1-24

Gain summary tables for nodes and percentiles

<table>
<thead>
<tr>
<th>N</th>
<th>Percent</th>
<th>Profit</th>
<th>ROI</th>
</tr>
</thead>
<tbody>
<tr>
<td>732</td>
<td>13.1%</td>
<td>77,826</td>
<td>377.4%</td>
</tr>
<tr>
<td>990</td>
<td>15.8%</td>
<td>70,000</td>
<td>300.0%</td>
</tr>
<tr>
<td>455</td>
<td>10.3%</td>
<td>97,692</td>
<td>267.8%</td>
</tr>
<tr>
<td>493</td>
<td>19.9%</td>
<td>49,426</td>
<td>172.0%</td>
</tr>
<tr>
<td>261</td>
<td>10.8%</td>
<td>26,416</td>
<td>64.7%</td>
</tr>
<tr>
<td>553</td>
<td>22.4%</td>
<td>22,622</td>
<td>61.5%</td>
</tr>
</tbody>
</table>

Gain Summary for Percentiles

<table>
<thead>
<tr>
<th>Percentile</th>
<th>Nodes</th>
<th>N</th>
<th>Profit</th>
<th>ROI</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>7</td>
<td>246</td>
<td>77,826</td>
<td>377.4%</td>
</tr>
<tr>
<td>20</td>
<td>7, 5</td>
<td>459</td>
<td>75,219</td>
<td>352.0%</td>
</tr>
<tr>
<td>30</td>
<td>5, 6</td>
<td>359</td>
<td>73,489</td>
<td>336.2%</td>
</tr>
<tr>
<td>40</td>
<td>6</td>
<td>288</td>
<td>72,036</td>
<td>323.4%</td>
</tr>
<tr>
<td>50</td>
<td>6, 9</td>
<td>1,232</td>
<td>70,306</td>
<td>307.9%</td>
</tr>
<tr>
<td>60</td>
<td>9</td>
<td>1,478</td>
<td>86,745</td>
<td>290.6%</td>
</tr>
<tr>
<td>70</td>
<td>9, 8</td>
<td>1,725</td>
<td>83,134</td>
<td>251.4%</td>
</tr>
<tr>
<td>80</td>
<td>9, 1</td>
<td>1,971</td>
<td>90,149</td>
<td>221.8%</td>
</tr>
<tr>
<td>90</td>
<td>1</td>
<td>2,216</td>
<td>54,163</td>
<td>197.8%</td>
</tr>
<tr>
<td>100</td>
<td>1</td>
<td>2,464</td>
<td>51,323</td>
<td>192.4%</td>
</tr>
</tbody>
</table>

By target category. For categorical dependent variables with defined target categories, the table includes the percentage gain, the response percentage, and the index percentage (lift) by node or percentile group. A separate table is produced for each target category. Not available for scale dependent variables or categorical dependent variables without defined target categories. For more information, see the topic Selecting Categories on p. 6.

Figure 1-25

Target category gains for nodes and percentiles

Target Category: Bad

Gains for Nodes

<table>
<thead>
<tr>
<th>Node</th>
<th>N</th>
<th>Percent</th>
<th>Gain</th>
<th>N</th>
<th>Percent</th>
<th>Response</th>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>553</td>
<td>22.4%</td>
<td>454</td>
<td>41.8%</td>
<td>82.1%</td>
<td>108.3%</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>261</td>
<td>19.6%</td>
<td>211</td>
<td>20.7%</td>
<td>80.8%</td>
<td>195.3%</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>455</td>
<td>19.8%</td>
<td>211</td>
<td>20.7%</td>
<td>43.7%</td>
<td>105.5%</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>455</td>
<td>19.8%</td>
<td>82</td>
<td>7.8%</td>
<td>17.6%</td>
<td>42.5%</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>390</td>
<td>15.8%</td>
<td>64</td>
<td>5.3%</td>
<td>13.6%</td>
<td>33.4%</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>322</td>
<td>13.1%</td>
<td>10</td>
<td>1.0%</td>
<td>3.1%</td>
<td>7.5%</td>
<td></td>
</tr>
</tbody>
</table>

Gains for Percentiles

<table>
<thead>
<tr>
<th>Percentile</th>
<th>Nodes</th>
<th>N</th>
<th>Gain</th>
<th>N</th>
<th>Percent</th>
<th>Response</th>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>1</td>
<td>246</td>
<td>202</td>
<td>12.8%</td>
<td>82.1%</td>
<td>108.3%</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>1</td>
<td>493</td>
<td>405</td>
<td>38.7%</td>
<td>92.1%</td>
<td>190.3%</td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>1, 8</td>
<td>739</td>
<td>604</td>
<td>59.3%</td>
<td>81.8%</td>
<td>197.8%</td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>6, 9</td>
<td>916</td>
<td>740</td>
<td>72.6%</td>
<td>75.1%</td>
<td>161.3%</td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>9</td>
<td>1,232</td>
<td>848</td>
<td>85.1%</td>
<td>68.6%</td>
<td>161.2%</td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>9, 6</td>
<td>1,426</td>
<td>998</td>
<td>89.0%</td>
<td>61.4%</td>
<td>148.4%</td>
<td></td>
</tr>
<tr>
<td>70</td>
<td>6</td>
<td>1,725</td>
<td>951</td>
<td>93.3%</td>
<td>55.1%</td>
<td>133.2%</td>
<td></td>
</tr>
<tr>
<td>80</td>
<td>6, 5</td>
<td>1,971</td>
<td>988</td>
<td>95.7%</td>
<td>50.0%</td>
<td>120.0%</td>
<td></td>
</tr>
<tr>
<td>90</td>
<td>6, 7</td>
<td>2,216</td>
<td>1,012</td>
<td>98.3%</td>
<td>45.6%</td>
<td>110.3%</td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>7</td>
<td>2,464</td>
<td>1,023</td>
<td>100.0%</td>
<td>41.4%</td>
<td>100.0%</td>
<td></td>
</tr>
</tbody>
</table>
**Rows.** The node performance tables can display results by terminal nodes, percentiles, or both. If you select both, two tables are produced for each target category. Percentile tables display cumulative values for each percentile, based on sort order.

**Percentile increment.** For percentile tables, you can select the percentile increment: 1, 2, 5, 10, 20, or 25.

**Display cumulative statistics.** For terminal node tables, displays additional columns in each table with cumulative results.

**Charts**

Figure 1-26  
*Output dialog box, Plots tab*

Available charts depend on the measurement level of the dependent variable, the growing method, and other settings.

**Independent variable importance to model.** Bar chart of model importance by independent variable (predictor). Available only with the CRT growing method.

**Node Performance**

**Gain.** Gain is the percentage of total cases in the target category in each node, computed as: (node target \( n / \) total target \( n \)) \times 100. The gains chart is a line chart of cumulative percentile gains, computed as: (cumulative percentile target \( n / \) total target \( n \)) \times 100. A separate line chart is
produced for each target category. Available only for categorical dependent variables with defined target categories. For more information, see the topic Selecting Categories on p. 6.

The gains chart plots the same values that you would see in the Gain Percent column in the gains for percentiles table, which also reports cumulative values.

**Figure 1-27**

*Gains for percentiles table and gains chart*

<table>
<thead>
<tr>
<th>Percentile</th>
<th>Node</th>
<th>N</th>
<th>M</th>
<th>Gain Percent</th>
<th>Response Percent</th>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>1</td>
<td>286</td>
<td>203</td>
<td>19.0%</td>
<td>82.1%</td>
<td>180.3%</td>
</tr>
<tr>
<td>30</td>
<td>1 , 8</td>
<td>736</td>
<td>604</td>
<td>59.3%</td>
<td>81.8%</td>
<td>189.6%</td>
</tr>
<tr>
<td>50</td>
<td>8 , 9</td>
<td>986</td>
<td>740</td>
<td>72.6%</td>
<td>75.1%</td>
<td>181.3%</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>63.1%</td>
<td>66.3%</td>
<td>166.2%</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>69.0%</td>
<td>61.1%</td>
<td>143.4%</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>50.3%</td>
<td>55.1%</td>
<td>100.2%</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>56.7%</td>
<td>50.0%</td>
<td>120.9%</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>59.3%</td>
<td>45.6%</td>
<td>110.3%</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>100.0%</strong></td>
<td><strong>100.0%</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Index.** Index is the ratio of the node response percentage for the target category compared to the overall target category response percentage for the entire sample. The index chart is a line chart of cumulative percentile index values. Available only for categorical dependent variables. Cumulative percentile index is computed as: (cumulative percentile response percent / total response percent) x 100. A separate chart is produced for each target category, and target categories must be defined.

The index chart plots the same values that you would see in the Index column in the gains for percentiles table.
Figure 1-28
Gains for percentiles table and index chart

<table>
<thead>
<tr>
<th>Percentile</th>
<th>Node</th>
<th>N</th>
<th>Gain</th>
<th>N</th>
<th>Percent</th>
<th>Response</th>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>1</td>
<td>246</td>
<td>202</td>
<td>19.9%</td>
<td>80.1%</td>
<td>150.3%</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>1</td>
<td>493</td>
<td>405</td>
<td>39.7%</td>
<td>82.1%</td>
<td>158.3%</td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>1, 2</td>
<td>738</td>
<td>504</td>
<td>59.3%</td>
<td>61.8%</td>
<td>127.5%</td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>9</td>
<td>908</td>
<td>740</td>
<td>72.6%</td>
<td>75.1%</td>
<td>161.3%</td>
<td></td>
</tr>
</tbody>
</table>

**Response.** The percentage of cases in the node in the specified target category. The response chart is a line chart of cumulative percentile response, computed as: \((\text{cumulative percentile target } n / \text{cumulative percentile total } n) \times 100\). Available only for categorical dependent variables with defined target categories.

The response chart plots the same values that you would see in the **Response** column in the gains for percentiles table.
Figure 1-29
Gains for percentiles table and response chart

<table>
<thead>
<tr>
<th>Percentile</th>
<th>N Hosp</th>
<th>N</th>
<th>Percent</th>
<th>Responses</th>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>1</td>
<td>246</td>
<td>202</td>
<td>19.6%</td>
<td>82.1%</td>
</tr>
<tr>
<td>20</td>
<td>1</td>
<td>407</td>
<td>403</td>
<td>39.7%</td>
<td>82.1%</td>
</tr>
<tr>
<td>30</td>
<td>1; 8</td>
<td>736</td>
<td>624</td>
<td>52.2%</td>
<td>81.2%</td>
</tr>
<tr>
<td>40</td>
<td>8; 5</td>
<td>976</td>
<td>726</td>
<td>73.4%</td>
<td>75.1%</td>
</tr>
</tbody>
</table>

Mean. Line chart of cumulative percentile mean values for the dependent variable. Available only for scale dependent variables.

Average profit. Line chart of cumulative average profit. Available only for categorical dependent variables with defined profits. For more information, see the topic Profits on p. 17.

The average profit chart plots the same values that you would see in the Profit column in the gain summary for percentiles table.
Return on investment (ROI). Line chart of cumulative ROI (return on investment). ROI is computed as the ratio of profits to expenses. Available only for categorical dependent variables with defined profits.

The ROI chart plots the same values that you would see in the ROI column in the gain summary for percentiles table.
Figure 1-31
*Gain summary for percentiles table and ROI chart*

<table>
<thead>
<tr>
<th>Percentile</th>
<th>Nodes</th>
<th>N</th>
<th>Profit</th>
<th>ROI</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>7</td>
<td>246</td>
<td>77,826</td>
<td>377.4%</td>
</tr>
<tr>
<td>20</td>
<td>7 ; 5</td>
<td>490</td>
<td>71,210</td>
<td>352.0%</td>
</tr>
<tr>
<td>30</td>
<td>5 ; 8</td>
<td>759</td>
<td>73,408</td>
<td>398.2%</td>
</tr>
<tr>
<td>40</td>
<td>6</td>
<td>930</td>
<td>72,036</td>
<td>323.4%</td>
</tr>
</tbody>
</table>

**Percentile increment.** For all percentile charts, this setting controls the percentile increments displayed on the chart: 1, 2, 5, 10, 20, or 25.
**Selection and Scoring Rules**

Figure 1-32
*Output dialog box, Rules tab*

The Rules tab provides the ability to generate selection or classification/prediction rules in the form of command syntax, SQL, or simple (plain English) text. You can display these rules in the Viewer and/or save the rules to an external file.

**Syntax.** Controls the form of the selection rules in both output displayed in the Viewer and selection rules saved to an external file.

- **IBM® SPSS® Statistics.** Command syntax language. Rules are expressed as a set of commands that define a filter condition that can be used to select subsets of cases or as `COMPUTE` statements that can be used to score cases.

- **SQL.** Standard SQL rules are generated to select or extract records from a database or assign values to those records. The generated SQL rules do not include any table names or other data source information.

- **Simple text.** Plain English pseudo-code. Rules are expressed as a set of logical “if...then” statements that describe the model’s classifications or predictions for each node. Rules in this form can use defined variable and value labels or variable names and data values.

**Type.** For SPSS Statistics and SQL rules, controls the type of rules generated: selection or scoring rules.
Chapter 1

- **Assign values to cases.** The rules can be used to assign the model’s predictions to cases that meet node membership criteria. A separate rule is generated for each node that meets the node membership criteria.

- **Select cases.** The rules can be used to select cases that meet node membership criteria. For SPSS Statistics and SQL rules, a single rule is generated to select all cases that meet the selection criteria.

**Include surrogates in SPSS Statistics and SQL rules.** For CRT and QUEST, you can include surrogate predictors from the model in the rules. Rules that include surrogates can be quite complex. In general, if you just want to derive conceptual information about your tree, exclude surrogates. If some cases have incomplete independent variable (predictor) data and you want rules that mimic your tree, include surrogates. For more information, see the topic Surrogates on p. 15.

**Nodes.** Controls the scope of the generated rules. A separate rule is generated for each node included in the scope.

- **All terminal nodes.** Generates rules for each terminal node.

- **Best terminal nodes.** Generates rules for the top \( n \) terminal nodes based on index values. If the number exceeds the number of terminal nodes in the tree, rules are generated for all terminal nodes. (See note below.)

- **Best terminal nodes up to a specified percentage of cases.** Generates rules for terminal nodes for the top \( n \) percentage of cases based on index values. (See note below.)

- **Terminal nodes whose index value meets or exceeds a cutoff value.** Generates rules for all terminal nodes with an index value greater than or equal to the specified value. An index value greater than 100 means that the percentage of cases in the target category in that node exceeds the percentage in the root node. (See note below.)

- **All nodes.** Generates rules for all nodes.

**Note 1:** Node selection based on index values is available only for categorical dependent variables with defined target categories. If you have specified multiple target categories, a separate set of rules is generated for each target category.

**Note 2:** For SPSS Statistics and SQL rules for selecting cases (not rules for assigning values), All nodes and All terminal nodes will effectively generate a rule that selects all cases used in the analysis.

**Export rules to a file.** Saves the rules in an external text file.

You can also generate and save selection or scoring rules interactively, based on selected nodes in the final tree model. For more information, see the topic Case Selection and Scoring Rules in Chapter 2 on p. 44.

**Note:** If you apply rules in the form of command syntax to another data file, that data file must contain variables with the same names as the independent variables included in the final model, measured in the same metric, with the same user-defined missing values (if any).
Tree Editor

With the Tree Editor, you can:

- Hide and show selected tree branches.
- Control display of node content, statistics displayed at node splits, and other information.
- Change node, background, border, chart, and font colors.
- Change font style and size.
- Change tree alignment.
- Select subsets of cases for further analysis based on selected nodes.
- Create and save rules for selecting or scoring cases based on selected nodes.

To edit a tree model:

- Double-click the tree model in the Viewer window.

or

- From the Edit menu or the right-click context menu choose:
  Edit Content > In Separate Window

**Hiding and Showing Nodes**

To hide (collapse) all the child nodes in a branch beneath a parent node:

- Click the minus sign (–) in the small box below the lower right corner of the parent node.

All nodes beneath the parent node on that branch will be hidden.

To show (expand) the child nodes in a branch beneath a parent node:

- Click the plus sign (+) in the small box below the lower right corner of the parent node.

*Note: Hiding the child nodes on a branch is not the same as pruning a tree. If you want a pruned tree, you must request pruning before you create the tree, and pruned branches are not included in the final tree. For more information, see the topic Pruning Trees in Chapter 1 on p. 14.*
Figure 2-1
Expanded and collapsed tree

Selecting Multiple Nodes

You can select cases, generate scoring and selections rules, and perform other actions based on the currently selected node(s). To select multiple nodes:

► Click a node you want to select.
► Ctrl-click the other nodes you want to select.

You can multiple-select sibling nodes and/or parent nodes in one branch and child nodes in another branch. You cannot, however, use multiple selection on a parent node and a child/descendant of the same node branch.

Working with Large Trees

Tree models may sometimes contain so many nodes and branches that it is difficult or impossible to view the entire tree at full size. There are a number of features that you may find useful when working with large trees:

► Tree map. You can use the tree map, a much smaller, simplified version of the tree, to navigate the tree and select nodes. For more information, see the topic Tree Map on p. 39.

► Scaling. You can zoom out and zoom in by changing the scale percentage for the tree display. For more information, see the topic Scaling the Tree Display on p. 39.

► Node and branch display. You can make a tree more compact by displaying only tables or only charts in the nodes and/or suppressing the display of node labels or independent variable information. For more information, see the topic Controlling Information Displayed in the Tree on p. 41.
Tree Map

The tree map provides a compact, simplified view of the tree that you can use to navigate the tree and select nodes.

To use the tree map window:

► From the Tree Editor menus choose:
View > Tree Map

Figure 2-2
Tree map window

- The currently selected node is highlighted in both the Tree Model Editor and the tree map window.
- The portion of the tree that is currently in the Tree Model Editor view area is indicated with a red rectangle in the tree map. Right-click and drag the rectangle to change the section of the tree displayed in the view area.
- If you select a node in the tree map that isn’t currently in the Tree Editor view area, the view shifts to include the selected node.
- Multiple node selection works the same in the tree map as in the Tree Editor: Ctrl-click to select multiple nodes. You cannot use multiple selection on a parent node and a child/descendant of the same node branch.

Scaling the Tree Display

By default, trees are automatically scaled to fit in the Viewer window, which can result in some trees that are initially very difficult to read. You can select a preset scale setting or enter your own custom scale value of between 5% and 200%.

To change the scale of the tree:

► Select a scale percentage from the drop-down list on the toolbar, or enter a custom percentage value.

or

► From the Tree Editor menus choose:
View > Scale...
You can also specify a scale value before you create the tree model. For more information, see the topic Output in Chapter 1 on p. 23.

**Node Summary Window**

The node summary window provides a larger view of the selected nodes. You can also use the summary window to view, apply, or save selection or scoring rules based on the selected nodes.

- Use the View menu in the node summary window to switch between views of a summary table, chart, or rules.
- Use the Rules menu in the node summary window to select the type of rules you want to see. For more information, see the topic Case Selection and Scoring Rules on p. 44.
- All views in the node summary window reflect a combined summary for all selected nodes.

To use the node summary window:

- Select the nodes in the Tree Editor. To select multiple nodes, use Ctrl-click.
- From the menus choose:
  - View > Summary
Controlling Information Displayed in the Tree

The Options menu in the Tree Editor allows you to control the display of node contents, independent variable (predictor) names and statistics, node definitions, and other settings. Many of these settings can be also be controlled from the toolbar.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options Menu Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highlight predicted category (categorical dependent variable)</td>
<td>Highlight Predicted</td>
</tr>
<tr>
<td>Tables and/or charts in node</td>
<td>Node Contents</td>
</tr>
<tr>
<td>Significance test values and p values</td>
<td>Independent Variable Statistics</td>
</tr>
<tr>
<td>Independent (predictor) variable names</td>
<td>Independent Variables</td>
</tr>
<tr>
<td>Independent (predictor) value(s) for nodes</td>
<td>Node Definitions</td>
</tr>
<tr>
<td>Alignment (top-down, left-right, right-left)</td>
<td>Orientation</td>
</tr>
<tr>
<td>Chart legend</td>
<td>Legend</td>
</tr>
</tbody>
</table>
Figure 2-5
Tree elements

Changing Tree Colors and Text Fonts

You can change the following colors in the tree:

- Node border, background, and text color
- Branch color and branch text color
- Tree background color
- Predicted category highlight color (categorical dependent variables)
- Node chart colors

You can also change the type font, style, and size for all text in the tree.

Note: You cannot change color or font attributes for individual nodes or branches. Color changes apply to all elements of the same type, and font changes (other than color) apply to all chart elements.

To change colors and text font attributes:

- Use the toolbar to change font attributes for the entire tree or colors for different tree elements. (ToolTips describe each control on the toolbar when you put the mouse cursor on the control.)
  or
- Double-click anywhere in the Tree Editor to open the Properties window, or from the menus choose:
  View > Properties
- For border, branch, node background, predicted category, and tree background, click the Color tab.
- For font colors and attributes, click the Text tab.
- For node chart colors, click the Node Charts tab.
Figure 2-6
Properties window, Color tab

Figure 2-7
Properties window, Text tab
Case Selection and Scoring Rules

You can use the Tree Editor to:

- Select subsets of cases based on the selected node(s). For more information, see the topic Filtering Cases on p. 44.
- Generate case selection rules or scoring rules in IBM® SPSS® Statistics command syntax or SQL format. For more information, see the topic Saving Selection and Scoring Rules on p. 45.

You can also automatically save rules based on various criteria when you run the Decision Tree procedure to create the tree model. For more information, see the topic Selection and Scoring Rules in Chapter 1 on p. 35.

Filtering Cases

If you want to know more about the cases in a particular node or group of nodes, you can select a subset of cases for further analysis based on the selected nodes.

- Select the nodes in the Tree Editor. To select multiple nodes, use Ctrl-click.
- From the menus choose:
  Rules > Filter Cases...
- Enter a filter variable name. Cases from the selected nodes will receive a value of 1 for this variable. All other cases will receive a value of 0 and will be excluded from subsequent analysis until you change the filter status.
- Click OK.
Saving Selection and Scoring Rules

You can save case selection or scoring rules in an external file and then apply those rules to a different data source. The rules are based on the selected nodes in the Tree Editor.

**Syntax.** Controls the form of the selection rules in both output displayed in the Viewer and selection rules saved to an external file.

- **IBM® SPSS® Statistics.** Command syntax language. Rules are expressed as a set of commands that define a filter condition that can be used to select subsets of cases or as `COMPUTE` statements that can be used to score cases.
- **SQL.** Standard SQL rules are generated to select/extract records from a database or assign values to those records. The generated SQL rules do not include any table names or other data source information.

**Type.** You can create selection or scoring rules.

- **Select cases.** The rules can be used to select cases that meet node membership criteria. For SPSS Statistics and SQL rules, a single rule is generated to select all cases that meet the selection criteria.
- **Assign values to cases.** The rules can be used to assign the model’s predictions to cases that meet node membership criteria. A separate rule is generated for each node that meets the node membership criteria.

**Include surrogates.** For CRT and QUEST, you can include surrogate predictors from the model in the rules. Rules that include surrogates can be quite complex. In general, if you just want to derive conceptual information about your tree, exclude surrogates. If some cases have incomplete independent variable (predictor) data and you want rules that mimic your tree, include surrogates. For more information, see the topic Surrogates in Chapter 1 on p. 15.

To save case selection or scoring rules:

- Select the nodes in the Tree Editor. To select multiple nodes, use Ctrl-click.

- From the menus choose:
  
- Rules > Export...

- Select the type of rules you want and enter a filename.
Note: If you apply rules in the form of command syntax to another data file, that data file must contain variables with the same names as the independent variables included in the final model, measured in the same metric, with the same user-defined missing values (if any).
Part II:
Examples
The Decision Tree procedure assumes that:
- The appropriate measurement level has been assigned to all analysis variables.
- For categorical (nominal, ordinal) dependent variables, value labels have been defined for all categories that should be included in the analysis.

We’ll use the file `tree_textdata.sav` to illustrate the importance of both of these requirements. This data file reflects the default state of data read or entered before defining any attributes, such as measurement level or value labels. For more information, see the topic Sample Files in Appendix A in *IBM SPSS Decision Trees 19*.

**Effects of measurement level on tree models**

Both variables in this data file are numeric, and both have been assigned the `scale` measurement level. But (as we will see later) both variables are really categorical variables that rely on numeric codes to stand for category values.

- To run a Decision Tree analysis, from the menus choose:
  Analyze > Classify > Tree...
The icons next to the two variables in the source variable list indicate that they will be treated as scale variables.

**Figure 3-1**  
*Decision Tree main dialog box with two scale variables*

- Select *dependent* as the dependent variable.
- Select *independent* as the independent variable.
- Click OK to run the procedure.
- Open the Decision Tree dialog box again and click **Reset**.
- Right-click *dependent* in the source list and select **Nominal** from the context menu.
- Do the same for the variable *independent* in the source list.
Chapter 3

Now the icons next to each variable indicate that they will be treated as nominal variables.

**Figure 3-2**
Nominal icons in source list

![Decision Tree](image)

Select *dependent* as the dependent variable and *independent* as the independent variable, and click OK to run the procedure again.

Now let’s compare the two trees. First, we’ll look at the tree in which both numeric variables are treated as scale variables.

**Figure 3-3**
Tree with both variables treated as scale

![Tree with both variables treated as scale](image)
Each node of tree shows the “predicted” value, which is the mean value for the dependent variable at that node. For a variable that is actually categorical, the mean may not be a meaningful statistic.

The tree has four child nodes, one for each value of the independent variable.

Tree models will often merge similar nodes, but for a scale variable, only contiguous values can be merged. In this example, no contiguous values were considered similar enough to merge any nodes together.

The tree in which both variables are treated as nominal is somewhat different in several respects.

Instead of a predicted value, each node contains a frequency table that shows the number of cases (count and percentage) for each category of the dependent variable.

The “predicted” category—the category with the highest count in each node—is highlighted. For example, the predicted category for node 2 is category 3.

Instead of four child nodes, there are only three, with two values of the independent variable merged into a single node.

The two independent values merged into the same node are 1 and 4. Since, by definition, there is no inherent order to nominal values, merging of noncontiguous values is allowed.

**Permanently assigning measurement level**

When you change the measurement level for a variable in the Decision Tree dialog box, the change is only temporary; it is not saved with the data file. Furthermore, you may not always know what the correct measurement level should be for all variables.

Define Variable Properties can help you determine the correct measurement level for each variable and permanently change the assigned measurement level. To use Define Variable Properties:

> From the menus choose:
> Data > Define Variable Properties...
Variables with an unknown measurement level

The Measurement Level alert is displayed when the measurement level for one or more variables (fields) in the dataset is unknown. Since measurement level affects the computation of results for this procedure, all variables must have a defined measurement level.

Figure 3-5
Measurement level alert

- **Scan Data.** Reads the data in the active dataset and assigns default measurement level to any fields with a currently unknown measurement level. If the dataset is large, that may take some time.

- **Assign Manually.** Opens a dialog that lists all fields with an unknown measurement level. You can use this dialog to assign measurement level to those fields. You can also assign measurement level in Variable View of the Data Editor.

Since measurement level is important for this procedure, you cannot access the dialog to run this procedure until all fields have a defined measurement level.

Effects of value labels on tree models

The Decision Tree dialog box interface assumes that either all nonmissing values of a categorical (nominal, ordinal) dependent variable have defined value labels or none of them do. Some features are not available unless at least two nonmissing values of the categorical dependent variable have value labels. If at least two nonmissing values have defined value labels, any cases with other values that do not have value labels will be excluded from the analysis.

The original data file in this example contains no defined value labels, and when the dependent variable is treated as nominal, the tree model uses all nonmissing values in the analysis. In this example, those values are 1, 2, and 3.

But what happens when we define value labels for some, but not all, values of the dependent variable?

- In the Data Editor window, click the Variable View tab.

- Click the Values cell for the variable dependent.
Data assumptions and requirements

First, enter 1 for Value and Yes for Value Label, and then click Add.

Next, enter 2 for Value and No for Value Label, and then click Add again.

Then click OK.

Open the Decision Tree dialog box again. The dialog box should still have dependent selected as the dependent variable, with a nominal measurement level.

Click OK to run the procedure again.

Now only the two dependent variable values with defined value labels are included in the tree model. All cases with a value of 3 for the dependent variable have been excluded, which might not be readily apparent if you aren’t familiar with the data.
Assigning value labels to all values

To avoid accidental omission of valid categorical values from the analysis, use Define Variable Properties to assign value labels to all dependent variable values found in the data.

When the data dictionary information for the variable name is displayed in the Define Variable Properties dialog box, you can see that although there are over 300 cases with a value of 3 for that variable, no value label has been defined for that value.

Figure 3-8
Variable with partial value labels in Define Variable Properties dialog box
Using Decision Trees to Evaluate Credit Risk

A bank maintains a database of historic information on customers who have taken out loans from the bank, including whether or not they repaid the loans or defaulted. Using a tree model, you can analyze the characteristics of the two groups of customers and build models to predict the likelihood that loan applicants will default on their loans.

The credit data are stored in `tree_credit.sav`. For more information, see the topic Sample Files in Appendix A in *IBM SPSS Decision Trees 19*.

Creating the Model

The Decision Tree Procedure offers several different methods for creating tree models. For this example, we’ll use the default method:

**CHAID.** Chi-squared Automatic Interaction Detection. At each step, CHAID chooses the independent (predictor) variable that has the strongest interaction with the dependent variable. Categories of each predictor are merged if they are not significantly different with respect to the dependent variable.

Building the CHAID Tree Model

To run a Decision Tree analysis, from the menus choose:

Analyze > Classify > Tree...
Select Credit rating as the dependent variable.

Select all the remaining variables as independent variables. (The procedure will automatically exclude any variables that don’t make a significant contribution to the final model.)

At this point, you could run the procedure and produce a basic tree model, but we’re going to select some additional output and make a few minor adjustments to the criteria used to generate the model.

Selecting Target Categories

Click the Categories button right below the selected dependent variable.
This opens the Categories dialog box, where you can specify the dependent variable target categories of interest. Target categories do not affect the tree model itself, but some output and options are available only if you have selected target categories.

Figure 4-2
Categories dialog box

- Select (check) the Target check box for the Bad category. Customers with a bad credit rating (defaulted on a loan) will be treated as the target category of interest.

- Click Continue.

**Specifying Tree Growing Criteria**

For this example, we want to keep the tree fairly simple, so we’ll limit the tree growth by raising the minimum number of cases for parent and child nodes.

- In the main Decision Tree dialog box, click Criteria.
In the Minimum Number of Cases group, type 400 for Parent Node and 200 for Child Node.

Click Continue.

**Selecting Additional Output**

In the main Decision Tree dialog box, click Output.
This opens a tabbed dialog box, where you can select various types of additional output.

**Figure 4-4**
*Output dialog box, Tree tab*

- On the Tree tab, select (check) **Tree in table format**.
- Then click the **Plots** tab.
Select (check) Gain and Index.

Note: These charts require a target category for the dependent variable. In this example, the Plots tab isn’t accessible until after you have specified one or more target categories.

Click Continue.

**Saving Predicted Values**

You can save variables that contain information about model predictions. For example, you can save the credit rating predicted for each case and then compare those predictions to the actual credit ratings.

In the main Decision Tree dialog box, click Save.
Select (check) Terminal node number, Predicted value, and Predicted probabilities.

Click Continue.

In the main Decision Tree dialog box, click OK to run the procedure.

Evaluating the Model

For this example, the model results include:
- Tables that provide information about the model.
- Tree diagram.
- Charts that provide an indication of model performance.
- Model prediction variables added to the active dataset.
Model Summary Table

Figure 4-7
Model summary

<table>
<thead>
<tr>
<th>Specifications</th>
<th>Growing Method</th>
<th>CHILD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dependent Variable</td>
<td>Credit rating</td>
<td>Age, Income, Credit cards, Education, Car loans</td>
</tr>
<tr>
<td>Independent Variables</td>
<td></td>
<td>NONE</td>
</tr>
<tr>
<td>Validation</td>
<td>Maximum Tree Depth</td>
<td>3</td>
</tr>
<tr>
<td>Minimum Cases in Parent Node</td>
<td>400</td>
<td></td>
</tr>
<tr>
<td>Minimum Cases in Child Node</td>
<td>2000</td>
<td></td>
</tr>
<tr>
<td>Results</td>
<td>Number of Nodes</td>
<td>10</td>
</tr>
<tr>
<td>Number of Terminal Nodes</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Depth</td>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>

The model summary table provides some very broad information about the specifications used to build the model and the resulting model.

- The Specifications section provides information on the settings used to generate the tree model, including the variables used in the analysis.
- The Results section displays information on the number of total and terminal nodes, depth of the tree (number of levels below the root node), and independent variables included in the final model.

Five independent variables were specified, but only three were included in the final model. The variables for education and number of current car loans did not make a significant contribution to the model, so they were automatically dropped from the final model.
Using Decision Trees to Evaluate Credit Risk

The tree diagram is a graphic representation of the tree model. This tree diagram shows that:

- Using the CHAID method, **income level** is the best predictor of **credit rating**.
- For the low income category, **income level** is the only significant predictor of **credit rating**. Of the bank customers in this category, 82% have defaulted on loans. Since there are no child nodes below it, this is considered a **terminal** node.
- For the medium and high income categories, the next best predictor is **number of credit cards**.
- For medium income customers with five or more credit cards, the model includes one more predictor: **age**. Over 80% of those customers 28 or younger have a bad credit rating, while slightly less than half of those over 28 have a bad credit rating.

You can use the Tree Editor to hide and show selected branches, change colors and fonts, and select subsets of cases based on selected nodes. For more information, see the topic Selecting Cases in Nodes on p. 69.
Tree Table

Figure 4-9
Tree table for credit rating

<table>
<thead>
<tr>
<th>Node</th>
<th>Bad</th>
<th>Good</th>
<th>Total</th>
<th>Predicted Category</th>
<th>Parent Node</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>Percent</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>1020</td>
<td>1444</td>
<td>2464</td>
<td>100.0%</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>454</td>
<td>99</td>
<td>553</td>
<td>22.4%</td>
<td>Bed</td>
</tr>
<tr>
<td>2</td>
<td>476</td>
<td>659</td>
<td>1134</td>
<td>48.0%</td>
<td>Good</td>
</tr>
<tr>
<td>3</td>
<td>90</td>
<td>1165</td>
<td>1255</td>
<td>31.5%</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>422</td>
<td>557</td>
<td>979</td>
<td>30.2%</td>
<td>Bed</td>
</tr>
<tr>
<td>5</td>
<td>34</td>
<td>336</td>
<td>370</td>
<td>15.8%</td>
<td>Good</td>
</tr>
<tr>
<td>6</td>
<td>20</td>
<td>375</td>
<td>395</td>
<td>10.0%</td>
<td>Good</td>
</tr>
<tr>
<td>7</td>
<td>10</td>
<td>912</td>
<td>922</td>
<td>13.1%</td>
<td>Good</td>
</tr>
<tr>
<td>8</td>
<td>211</td>
<td>272</td>
<td>483</td>
<td>19.5%</td>
<td></td>
</tr>
</tbody>
</table>

The tree table, as the name suggests, provides most of the essential tree diagram information in the form of a table. For each node, the table displays:

- The number and percentage of cases in each category of the dependent variable.
- The predicted category for the dependent variable. In this example, the predicted category is the credit rating category with more than 50% of cases in that node, since there are only two possible credit ratings.
- The parent node for each node in the tree. Note that node 1—the low income level node—is not the parent node of any node. Since it is a terminal node, it has no child nodes.

Figure 4-10
Tree table for credit rating (continued)

<table>
<thead>
<tr>
<th>Primary Independent Variable</th>
<th>Sig.</th>
<th>CH-Square</th>
<th>df</th>
<th>Split Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Income level</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
<td>$\leq$ Low</td>
</tr>
<tr>
<td>Income level</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
<td>(Low, Medium)</td>
</tr>
<tr>
<td>Income level</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
<td>$&gt; \text{Medium}$</td>
</tr>
<tr>
<td>Number of credit cards</td>
<td>0.00</td>
<td>191.113</td>
<td>1</td>
<td>$\geq$ 5 or more</td>
</tr>
<tr>
<td>Number of credit cards</td>
<td>0.00</td>
<td>191.113</td>
<td>1</td>
<td>Less than 5</td>
</tr>
<tr>
<td>Age</td>
<td>0.00</td>
<td>36.557</td>
<td>1</td>
<td>$\geq$ 26.0792</td>
</tr>
<tr>
<td>Age</td>
<td>0.00</td>
<td>36.557</td>
<td>1</td>
<td>Less than 26.0792</td>
</tr>
</tbody>
</table>

- The independent variable used to split the node.
- The chi-square value (since the tree was generated with the CHAID method), degrees of freedom ($df$), and significance level (Sig.) for the split. For most practical purposes, you will probably be interested only in the significance level, which is less than 0.0001 for all splits in this model.
- The value(s) of the independent variable for that node.

Note: For ordinal and scale independent variables, you may see ranges in the tree and tree table expressed in the general form ($value1, value2$), which basically means “greater than value1 and less than or equal to value2.” In this example, income level has only three possible values—Low,
Medium, and High—and \((Low, Medium)\) simply means Medium. In a similar fashion, \(>Medium\) means High.

**Gains for Nodes**

The gains for nodes table provides a summary of information about the terminal nodes in the model.

- Only the terminal nodes—nodes at which the tree stops growing—are listed in this table. Frequently, you will be interested only in the terminal nodes, since they represent the best classification predictions for the model.
- Since gain values provide information about target categories, this table is available only if you specified one or more target categories. In this example, there is only one target category, so there is only one gains for nodes table.
- \(Node N\) is the number of cases in each terminal node, and \(Node Percent\) is the percentage of the total number of cases in each node.
- \(Gain N\) is the number of cases in each terminal node in the target category, and \(Gain Percent\) is the percentage of cases in the target category with respect to the overall number of cases in the target category—in this example, the number and percentage of cases with a bad credit rating.
- For categorical dependent variables, \(Response\) is the percentage of cases in the node in the specified target category. In this example, these are the same percentages displayed for the Bad category in the tree diagram.
- For categorical dependent variables, \(Index\) is the ratio of the response percentage for the target category compared to the response percentage for the entire sample.

**Index Values**

The index value is basically an indication of how far the observed target category percentage for that node differs from the expected percentage for the target category. The target category percentage in the root node represents the expected percentage before the effects of any of the independent variables are considered.

An index value of greater than 100% means that there are more cases in the target category than the overall percentage in the target category. Conversely, an index value of less than 100% means there are fewer cases in the target category than the overall percentage.
Chapter 4

**Gains Chart**

Figure 4-12
Gains chart for bad credit rating target category

This gains chart indicates that the model is a fairly good one.

Cumulative gains charts always start at 0% and end at 100% as you go from one end to the other. For a good model, the gains chart will rise steeply toward 100% and then level off. A model that provides no information will follow the diagonal reference line.

**Index Chart**

Figure 4-13
Index chart for bad credit rating target category

The index chart also indicates that the model is a good one. Cumulative index charts tend to start above 100% and gradually descend until they reach 100%.
For a good model, the index value should start well above 100%, remain on a high plateau as you move along, and then trail off sharply toward 100%. For a model that provides no information, the line will hover around 100% for the entire chart.

**Risk Estimate and Classification**

Figure 4-14
Risk and classification tables

<table>
<thead>
<tr>
<th>Risk Estimate</th>
<th>Std. Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>205</td>
<td>10.0</td>
</tr>
</tbody>
</table>

Growth Method: CHAID
Dependent Variable: Credit rating

<table>
<thead>
<tr>
<th>Classification</th>
<th>Observed</th>
<th>Predicted</th>
<th>Percent Correct</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bad</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>Risk</td>
<td>855</td>
<td>205</td>
<td>85.2%</td>
</tr>
<tr>
<td>Good</td>
<td>140</td>
<td>1205</td>
<td>89.7%</td>
</tr>
<tr>
<td>Overall Percentage</td>
<td>33.0%</td>
<td>67.0%</td>
<td>79.5%</td>
</tr>
</tbody>
</table>

Growth Method: CHAID
Dependent Variable: Credit rating

The risk and classification tables provide a quick evaluation of how well the model works.

- The risk estimate of 0.205 indicates that the category predicted by the model (good or bad credit rating) is wrong for 20.5% of the cases. So the “risk” of misclassifying a customer is approximately 21%.

- The results in the classification table are consistent with the risk estimate. The table shows that the model classifies approximately 79.5% of the customers correctly.

The classification table does, however, reveal one potential problem with this model: for those customers with a bad credit rating, it predicts a bad rating for only 65% of them, which means that 35% of customers with a bad credit rating are inaccurately classified with the “good” customers.
Predicted Values

Figure 4-15
New variables for predicted values and probabilities

Four new variables have been created in the active dataset:

**NodeID.** The terminal node number for each case.

**PredictedValue.** The predicted value of the dependent variable for each case. Since the dependent variable is coded 0 = \textit{Bad} and 1 = \textit{Good}, a predicted value of 0 means that the case is predicted to have a bad credit rating.

**PredictedProbability.** The probability that the case belongs in each category of the dependent variable. Since there are only two possible values for the dependent variable, two variables are created:

- **PredictedProbability \_1.** The probability that the case belongs in the bad credit rating category.
- **PredictedProbability \_2.** The probability that the case belongs in the good credit rating category.

The predicted probability is simply the proportion of cases in each category of the dependent variable for the terminal node that contains each case. For example, in node 1, 82\% of the cases are in the bad category and 18\% are in the good category, resulting in predicted probabilities of 0.82 and 0.18, respectively.

For a categorical dependent variable, the predicted value is the category with the highest proportion of cases in the terminal node for each case. For example, for the first case, the predicted value is 1 (good credit rating), since approximately 56\% of the cases in its terminal node have a good credit rating. Conversely, for the second case, the predicted value is 0 (bad credit rating), since approximately 81\% of cases in its terminal node have a bad credit rating.

If you have defined costs, however, the relationship between predicted category and predicted probabilities may not be quite so straightforward. For more information, see the topic Assigning Costs to Outcomes on p. 72.
Refining the Model

Overall, the model has a correct classification rate of just under 80%. This is reflected in most of the terminal nodes, where the predicted category—the highlighted category in the node—is the same as the actual category for 80% or more of the cases.

There is, however, one terminal node where cases are fairly evenly split between good and bad credit ratings. In node 9, the predicted credit rating is “good,” but only 56% of the cases in that node actually have a good credit rating. That means that almost half of the cases in that node (44%) will have the wrong predicted category. And if the primary concern is identifying bad credit risks, this node doesn’t perform very well.

Selecting Cases in Nodes

Let’s look at the cases in node 9 to see if the data reveal any useful additional information.

- Double-click the tree in the Viewer to open the Tree Editor.
- Click node 9 to select it. (If you want to select multiple nodes, use Ctrl-click).
- From the Tree Editor menus choose:
  Rules > Filter Cases...

The Filter Cases dialog box will create a filter variable and apply a filter setting based on the values of that variable. The default filter variable name is filter_.

- Cases from the selected nodes will receive a value of 1 for the filter variable.
- All other cases will receive a value of 0 and will be excluded from subsequent analyses until you change the filter status.

In this example, that means cases that aren’t in node 9 will be filtered out (but not deleted) for now.

- Click OK to create the filter variable and apply the filter condition.
In the Data Editor, cases that have been filtered out are indicated with a diagonal slash through the row number. Cases that are not in node 9 are filtered out. Cases in node 9 are not filtered; so subsequent analyses will include only cases from node 9.

**Examining the Selected Cases**

As a first step in examining the cases in node 9, you might want to look at the variables not used in the model. In this example, all variables in the data file were included in the analysis, but two of them were not included in the final model: education and car loans. Since there’s probably a good reason why the procedure omitted them from the final model, they probably won’t tell us much, but let’s take a look anyway.

From the menus choose:
Analyze > Descriptive Statistics > Crosstabs...
Select **Credit rating** for the row variable.

- Select **Education** and **Car loans** for the column variables.

- Click **Cells**.

In the Percentages group, select (check) **Row**.

- Then click **Continue**, and in the main Crosstabs dialog box, click **OK** to run the procedure.
Examining the crosstabulations, you can see that for the two variables not included in the model, there isn’t a great deal of difference between cases in the good and bad credit rating categories.

**Figure 4-20**
*Crosstabulations for cases in selected node*

<table>
<thead>
<tr>
<th>Credit rating * Education Crosstabulation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Education</strong></td>
</tr>
<tr>
<td>High school</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>Bad</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Good</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Total</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Credit rating * Car Loans Crosstabulation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Car Loans</strong></td>
</tr>
<tr>
<td>None</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>Bad</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Good</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Total</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

- For *education*, slightly more than half of the cases with a bad credit rating have only a high school education, while slightly more than half with a good credit rating have a college education—but this difference is not statistically significant.
- For *car loans*, the percentage of good credit cases with only one or no car loans is higher than the corresponding percentage for bad credit cases, but the vast majority of cases in both groups has two or more car loans.

So, although you now get some idea of why these variables were not included in the final model, you unfortunately haven’t gained any insight into how to get better prediction for node 9. If there were other variables not specified for the analysis, you might want to examine some of them before proceeding.

**Assigning Costs to Outcomes**

As noted earlier, aside from the fact that almost half of the cases in node 9 fall in each credit rating category, the fact that the predicted category is “good” is problematic if your main objective is to build a model that correctly identifies bad credit risks. Although you may not be able to improve the performance of node 9, you can still refine the model to improve the rate of correct classification for bad credit rating cases—although this will also result in a higher rate of misclassification for good credit rating cases.

First, you need to turn off case filtering so that all cases will be used in the analysis again.

- From the menus choose:
  Data > Select Cases...
In the Select Cases dialog box, select All cases, and then click OK.

Figure 4-21
Select Cases dialog box

Open the Decision Tree dialog box again, and click Options.
Click the Misclassification Costs tab.

**Figure 4-22**
Options dialog box, Misclassification Costs tab

Select Custom, and for Bad Actual Category / Good Predicted Category, enter a value of 2. This tells the procedure that the “cost” of incorrectly classifying a bad credit risk as good is twice as high as the “cost” of incorrectly classifying a good credit risk as bad.

Click Continue, and then in the main dialog box, click OK to run the procedure.
At first glance, the tree generated by the procedure looks essentially the same as the original tree. Closer inspection, however, reveals that although the distribution of cases in each node hasn’t changed, some predicted categories have changed.

For the terminal nodes, the predicted category remains the same in all nodes except one: node 9. The predicted category is now Bad even though slightly more than half of the cases are in the Good category.

Since we told the procedure that there was a higher cost for misclassifying bad credit risks as good, any node where the cases are fairly evenly distributed between the two categories now has a predicted category of Bad even if a slight majority of cases is in the Good category.
This change in predicted category is reflected in the classification table.

**Figure 4-24**
Risk and classification tables based on adjusted costs

<table>
<thead>
<tr>
<th></th>
<th>Observed</th>
<th>Predicted</th>
<th>Percent Correct</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bad</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td><strong>Risk</strong></td>
<td>676</td>
<td>144</td>
<td>85.9%</td>
</tr>
<tr>
<td><strong>Classification</strong></td>
<td>421</td>
<td>1023</td>
<td>70.8%</td>
</tr>
<tr>
<td><strong>Overall Percentage</strong></td>
<td>52.6%</td>
<td>47.4%</td>
<td>77.1%</td>
</tr>
</tbody>
</table>

- Almost 86% of the bad credit risks are now correctly classified, compared to only 65% before.
- On the other hand, correct classification of good credit risks has decreased from 90% to 71%, and overall correct classification has decreased from 79.5% to 77.1%.

Note also that the risk estimate and the overall correct classification rate are no longer consistent with each other. You would expect a risk estimate of 0.229 if the overall correct classification rate is 77.1%. Increasing the cost of misclassification for bad credit cases has, in this example, inflated the risk value, making its interpretation less straightforward.

**Summary**

You can use tree models to classify cases into groups identified by certain characteristics, such as the characteristics associated with bank customers with good and bad credit records. If a particular predicted outcome is more important than other possible outcomes, you can refine the model to associate a higher misclassification cost for that outcome—but reducing misclassification rates for one outcome will increase misclassification rates for other outcomes.
Building a Scoring Model

One of the most powerful and useful features of the Decision Tree procedure is the ability to build models that can then be applied to other data files to predict outcomes. For example, based on a data file that contains both demographic information and information on vehicle purchase price, we can build a model that can be used to predict how much people with similar demographic characteristics are likely to spend on a new car—and then apply that model to other data files where demographic information is available but information on previous vehicle purchasing is not.

For this example, we’ll use the data file \texttt{tree\_car.sav}. For more information, see the topic Sample Files in Appendix A in \textit{IBM SPSS Decision Trees 19}.

\textbf{Building the Model}

- To run a Decision Tree analysis, from the menus choose:
  Analyze > Classify > Tree...

\textit{Figure 5-1}
\textit{Decision Tree dialog box}

- Select \textit{Price of primary vehicle} as the dependent variable.

© Copyright SPSS Inc. 1989, 2010
Select all the remaining variables as independent variables. (The procedure will automatically exclude any variables that don’t make a significant contribution to the final model.)

For the growing method, select CRT.

Click Output.

Figure 5-2
Output dialog box, Rules tab

Click the Rules tab.

Select (check) Generate classification rules.

For Syntax, select IBM® SPSS® Statistics.

For Type, select Assign values to cases.

Select (check) Export rules to a file and enter a filename and directory location.

Remember the filename and location or write it down because you’ll need it a little later. If you don’t include a directory path, you may not know where the file has been saved. You can use the Browse button to navigate to a specific (and valid) directory location.

Click Continue, and then click OK to run the procedure and build the tree model.

Evaluating the Model

Before applying the model to other data files, you probably want to make sure that the model works reasonably well with the original data used to build it.
Model Summary

Figure 5-3
Model summary table

<table>
<thead>
<tr>
<th>Specifications</th>
<th>Growing Method</th>
<th>CRT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dependent Variables</td>
<td></td>
<td>Price of primary vehicle</td>
</tr>
<tr>
<td>Independent Variables</td>
<td></td>
<td>Age in years, Gender, Income category in thousands, Level of education, Marital status</td>
</tr>
<tr>
<td>Validation</td>
<td></td>
<td>NONE</td>
</tr>
<tr>
<td>Maximum Tree Depth</td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>Minimum Cases in Parent Node</td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>Minimum Cases in Child Node</td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>Independent Variables Included</td>
<td></td>
<td>Income category in thousands, Age in years, Level of education</td>
</tr>
<tr>
<td>Number of Nodes</td>
<td>29</td>
<td></td>
</tr>
<tr>
<td>Number of Terminal Nodes</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Death</td>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

The model summary table indicates that only three of the selected independent variables made a significant enough contribution to be included in the final model: *income, age, and education*. This is important information to know if you want to apply this model to other data files, since the independent variables used in the model must be present in any data file to which you want to apply the model.

The summary table also indicates that the tree model itself is probably not a particularly simple one since it has 29 nodes and 15 terminal nodes. This may not be an issue if you want a reliable model that can be applied in a practical fashion rather than a simple model that is easy to describe or explain. Of course, for practical purposes, you probably also want a model that doesn’t rely on too many independent (predictor) variables. In this case, that’s not a problem since only three independent variables are included in the final model.
Chapter 5

Tree Model Diagram

Figure 5-4
Tree model diagram in Tree Editor

The tree model diagram has so many nodes that it may be difficult to see the whole model at once at a size where you can still read the node content information. You can use the tree map to see the entire tree:

- Double-click the tree in the Viewer to open the Tree Editor.
- From the Tree Editor menus choose:
  View > Tree Map
The tree map shows the entire tree. You can change the size of the tree map window, and it will grow or shrink the map display of the tree to fit the window size.

The highlighted area in the tree map is the area of the tree currently displayed in the Tree Editor.

You can use the tree map to navigate the tree and select nodes.

For more information, see the topic Tree Map in Chapter 2 on p. 39.

For scale dependent variables, each node shows the mean and standard deviation of the dependent variable. Node 0 displays an overall mean vehicle purchase price of about 29.9 (in thousands), with a standard deviation of about 21.6.

- Node 1, which represents cases with an income of less than 75 (also in thousands) has a mean vehicle price of only 18.7.
- In contrast, node 2, which represents cases with an income of 75 or more, has a mean vehicle price of 60.9.

Further investigation of the tree would show that age and education also display a relationship with vehicle purchase price, but right now we’re primarily interested in the practical application of the model rather than a detailed examination of its components.

**Risk Estimate**

None of the results we’ve examined so far tell us if this is a particularly good model. One indicator of the model’s performance is the risk estimate. For a scale dependent variable, the risk estimate is a measure of the within-node variance, which by itself may not tell you a great deal. A lower variance indicates a better model, but the variance is relative to the unit of measurement.
Chapter 5

If, for example, price was recorded in ones instead of thousands, the risk estimate would be a thousand times larger.

To provide a meaningful interpretation for the risk estimate with a scale dependent variable requires a little work:

- Total variance equals the within-node (error) variance plus the between-node (explained) variance.
- The within-node variance is the risk estimate value: 68.485.
- The total variance is the variance for the dependent variables before consideration of any independent variables, which is the variance at the root node.
- The standard deviation displayed at the root node is 21.576; so the total variance is that value squared: 465.524.
- The proportion of variance due to error (unexplained variance) is 68.485 / 465.524 = 0.147.
- The proportion of variance explained by the model is 1 – 0.147 = 0.853, or 85.3%, which indicates that this is a fairly good model. (This has a similar interpretation to the overall correct classification rate for a categorical dependent variable.)

**Applying the Model to Another Data File**

Having determined that the model is reasonably good, we can now apply that model to other data files containing similar age, income, and education variables and generate a new variable that represents the predicted vehicle purchase price for each case in that file. This process is often referred to as **scoring**.

When we generated the model, we specified that “rules” for assigning values to cases should be saved in a text file—in the form of command syntax. We will now use the commands in that file to generate scores in another data file.

- Open the data file `tree_score_car.sav`. For more information, see the topic Sample Files in Appendix A in *IBM SPSS Decision Trees 19*.

- Next, from the menus choose:
  File > New > Syntax

- In the command syntax window, type:

  ```
  INSERT FILE= '/temp/car_scores.sps'.
  ```
If you used a different filename or location, make the appropriate changes.

**Figure 5-7**
Syntax window with INSERT command to run a command file

![Syntax window with INSERT command to run a command file](image)

The *INSERT* command will run the commands in the specified file, which is the “rules” file that was generated when we created the model.

- From the command syntax window menus choose:
  - Run > All

**Figure 5-8**
Predicted values added to data file

![Predicted values added to data file](image)

This adds two new variables to the data file:
- *nod_001* contains the terminal node number predicted by the model for each case.
- *pre_001* contains the predicted value for vehicle purchase price for each case.

Since we requested rules for assigning values for terminal nodes, the number of possible predicted values is the same as the number of terminal nodes, which in this case is 15. For example, every case with a predicted node number of 10 will have the same predicted vehicle purchase price:
30.56. This is, not coincidentally, the mean value reported for terminal node 10 in the original model.

Although you would typically apply the model to data for which the value of the dependent variable is not known, in this example the data file to which we applied the model actually contains that information—and you can compare the model predictions to the actual values.

► From the menus choose:
Analyze > Correlate > Bivariate...

► Select *Price of primary vehicle* and *pre_001*.

**Figure 5-9**
*Bivariate Correlations dialog box*

![Bivariate Correlations dialog box]

► Click OK to run the procedure.

**Figure 5-10**
*Correlation of actual and predicted vehicle price*

<table>
<thead>
<tr>
<th></th>
<th>Price of primary vehicle</th>
<th>pre_001</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price of primary vehicle</td>
<td>1</td>
<td>.919**</td>
</tr>
<tr>
<td>pre_001</td>
<td>3200</td>
<td>3200</td>
</tr>
</tbody>
</table>

*Correlation is significant at the 0.01 level (2-tailed).*

The correlation of 0.92 indicates a very high positive correlation between actual and predicted vehicle price, which indicates that the model works well.
Summary

You can use the Decision Tree procedure to build models that can then be applied to other data files to predict outcomes. The target data file must contain variables with the same names as the independent variables included in the final model, measured in the same metric and with the same user-defined missing values (if any). However, neither the dependent variable nor independent variables excluded from the final model need to be present in the target data file.
The different growing methods deal with missing values for independent (predictor) variables in different ways:

- **CHAID and Exhaustive CHAID** treat all system- and user-missing values for each independent variable as a single category. For scale and ordinal independent variables, that category may or may not subsequently get merged with other categories of that independent variable, depending on the growing criteria.

- **CRT and QUEST** attempt to use surrogates for independent (predictor) variables. For cases in which the value for that variable is missing, other independent variables having high associations with the original variable are used for classification. These alternative predictors are called surrogates.

This example shows the difference between CHAID and CRT when there are missing values for independent variables used in the model.

For this example, we’ll use the data file *tree_missing_data.sav*. For more information, see the topic Sample Files in Appendix A in *IBM SPSS Decision Trees 19*.

**Note:** For nominal independent variables and nominal dependent variables, you can choose to treat user-missing values as valid values, in which case those values are treated like any other nonmissing values. For more information, see the topic Missing Values in Chapter 1 on p. 21.
Missing Values with CHAID

Like the credit risk example (for more information, see Chapter 4), this example will try to build a model to classify good and bad credit risks. The main difference is that this data file contains missing values for some independent variables used in the model.

To run a Decision Tree analysis, from the menus choose:
Analyze > Classify > Tree...
Select *Credit rating* as the dependent variable.

- Select all of the remaining variables as independent variables. (The procedure will automatically exclude any variables that don’t make a significant contribution to the final model.)

- For the growing method, select CHAID.

  For this example, we want to keep the tree fairly simple; so, we’ll limit the tree growth by raising the minimum number of cases for the parent and child nodes.

- In the main Decision Tree dialog box, click Criteria.
For Minimum Number of Cases, type 400 for Parent Node and 200 for Child Node.

Click Continue, and then click OK to run the procedure.

**CHAID Results**

Figure 6-4  
**CHAID tree with missing independent variable values**
For node 3, the value of income level is displayed as >Medium;<missing>. This means that the node contains cases in the high-income category plus any cases with missing values for income level.

Terminal node 10 contains cases with missing values for number of credit cards. If you’re interested in identifying good credit risks, this is actually the second best terminal node, which might be problematic if you want to use this model for predicting good credit risks. You probably wouldn’t want a model that predicts a good credit rating simply because you don’t know anything about how many credit cards a case has, and some of those cases may also be missing income-level information.

Figure 6-5
Risk and classification tables for CHAID model

<table>
<thead>
<tr>
<th>Observed</th>
<th>Predicted</th>
<th>Percent Correct</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bad</td>
<td>608</td>
<td>364</td>
</tr>
<tr>
<td>Good</td>
<td>248</td>
<td>195</td>
</tr>
<tr>
<td>Overall Percentage</td>
<td>39.7%</td>
<td>62.3%</td>
</tr>
</tbody>
</table>

Missing Values with CRT

Now let’s try the same basic analysis, except we’ll use CRT as the growing method.

► In the main Decision Tree dialog box, for the growing method, select CRT.

► Click Criteria.

► Make sure that the minimum number of cases is still set at 400 for parent nodes and 200 for child nodes.

► Click the Surrogates tab.

Note: You will not see the Surrogates tab unless you have selected CRT or QUEST as the growing method.
For each independent variable node split, the Automatic setting will consider every other independent variable specified for the model as a possible surrogate. Since there aren’t very many independent variables in this example, the Automatic setting is fine.

- Click Continue.
- In the main Decision Tree dialog box, click Output.
Click the Statistics tab.

Select Surrogates by split.

Click Continue, and then click OK to run the procedure.
**CRT Results**

Figure 6-8

**CRT tree with missing independent variable values**

You may immediately notice that this tree doesn’t look much like the CHAID tree. That, by itself, doesn’t necessarily mean much. In a CRT tree model, all splits are binary; that is, each parent node is split into only two child nodes. In a CHAID model, parent nodes can be split into many child nodes. So, the trees will often look different even if they represent the same underlying model.

There are, however, a number of important differences:

- The most important independent (predictor) variable in the CRT model is *number of credit cards*, while in the CHAID model, the most important predictor was *income level*.
- For cases with less than five credit cards, *number of credit cards* is the only significant predictor of credit rating, and node 2 is a terminal node.
- As with the CHAID model, *income level* and *age* are also included in the model, although *income level* is now the second predictor rather than the first.
- There aren’t any nodes that contain a *<missing>* category, because CRT uses surrogate predictors rather than missing values in the model.
Chapter 6

Figure 6-9
Risk and classification tables for CRT model

<table>
<thead>
<tr>
<th>Risk</th>
<th>Estimate</th>
<th>Std Error</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>224</td>
<td>.006</td>
</tr>
</tbody>
</table>

Growing Method: CRT
Dependent Variable: Credit rating

<table>
<thead>
<tr>
<th>Classification</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Observed</td>
<td>Predicted</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bad</td>
<td>992</td>
<td>198</td>
<td>91.5%</td>
</tr>
<tr>
<td>Good</td>
<td>364</td>
<td>1006</td>
<td>74.5%</td>
</tr>
<tr>
<td>Overall Percentage</td>
<td>49.5%</td>
<td>51.5%</td>
<td>77.8%</td>
</tr>
</tbody>
</table>

Growing Method: CRT
Dependent Variable: Credit rating

- The risk and classification tables show an overall correct classification rate of almost 78%, a slight increase over the CHAID model (75%).
- The correct classification rate for bad credit cases is much higher for the CRT model—81.6% compared to only 64.3% for the CHAID model.
- The correct classification rate for good credit cases, however, has declined from 82.8% with CHAID to 74.8% with CRT.

Surrogates

The differences between the CHAID and CRT models are due, in part, to the use of surrogates in the CRT model. The surrogates table indicates how surrogates were used in the model.

Figure 6-10
Surrogates table

<table>
<thead>
<tr>
<th>Parent Node</th>
<th>Independent Variable</th>
<th>Improvement</th>
<th>Association</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Primary</td>
<td>Surrogate</td>
<td>0.031</td>
</tr>
<tr>
<td></td>
<td>Number of credit cards</td>
<td>Car loans</td>
<td>0.022</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Age</td>
<td>0.016</td>
</tr>
<tr>
<td>1</td>
<td>Primary</td>
<td>Surrogate</td>
<td>0.016</td>
</tr>
<tr>
<td></td>
<td>Income level</td>
<td>Age</td>
<td>0.022</td>
</tr>
<tr>
<td>3</td>
<td>Primary</td>
<td>Age</td>
<td>0.016</td>
</tr>
<tr>
<td>5</td>
<td>Primary</td>
<td>Surrogate</td>
<td>0.016</td>
</tr>
<tr>
<td></td>
<td>Income level</td>
<td>Age</td>
<td>0.022</td>
</tr>
</tbody>
</table>

Growing Method: CRT
Dependent Variable: Credit rating

- At the root node (node 0), the best independent (predictor) variable is number of credit cards.
- For any cases with missing values for number of credit cards, car loans is used as the surrogate predictor, since this variable has a fairly high association (0.643) with number of credit cards.
- If a case also has a missing value for car loans, then age is used as the surrogate (although it has a fairly low association value of only 0.004).
- Age is also used as a surrogate for income level at nodes 1 and 5.
Summary

Different growing methods handle missing data in different ways. If the data used to create the model contain many missing values—or if you want to apply that model to other data files that contain many missing values—you should evaluate the effect of missing values on the various models. If you want to use surrogates in the model to compensate for missing values, use the CRT or QUEST methods.
Sample Files

The sample files installed with the product can be found in the *Samples* subdirectory of the installation directory. There is a separate folder within the Samples subdirectory for each of the following languages: English, French, German, Italian, Japanese, Korean, Polish, Russian, Simplified Chinese, Spanish, and Traditional Chinese.

Not all sample files are available in all languages. If a sample file is not available in a language, that language folder contains an English version of the sample file.

**Descriptions**

Following are brief descriptions of the sample files used in various examples throughout the documentation.

- **accidents.sav.** This is a hypothetical data file that concerns an insurance company that is studying age and gender risk factors for automobile accidents in a given region. Each case corresponds to a cross-classification of age category and gender.

- **adl.sav.** This is a hypothetical data file that concerns efforts to determine the benefits of a proposed type of therapy for stroke patients. Physicians randomly assigned female stroke patients to one of two groups. The first received the standard physical therapy, and the second received an additional emotional therapy. Three months following the treatments, each patient’s abilities to perform common activities of daily life were scored as ordinal variables.

- **advert.sav.** This is a hypothetical data file that concerns a retailer’s efforts to examine the relationship between money spent on advertising and the resulting sales. To this end, they have collected past sales figures and the associated advertising costs.

- **aflatoxin.sav.** This is a hypothetical data file that concerns the testing of corn crops for aflatoxin, a poison whose concentration varies widely between and within crop yields. A grain processor has received 16 samples from each of 8 crop yields and measured the aflatoxin levels in parts per billion (PPB).

- **anorectic.sav.** While working toward a standardized symptomatology of anorectic/bulimic behavior, researchers made a study of 55 adolescents with known eating disorders. Each patient was seen four times over four years, for a total of 220 observations. At each observation, the patients were scored for each of 16 symptoms. Symptom scores are missing for patient 71 at time 2, patient 76 at time 2, and patient 47 at time 3, leaving 217 valid observations.

- **bankloan.sav.** This is a hypothetical data file that concerns a bank’s efforts to reduce the rate of loan defaults. The file contains financial and demographic information on 850 past and prospective customers. The first 700 cases are customers who were previously given
loans. The last 150 cases are prospective customers that the bank needs to classify as good or bad credit risks.

- **bankloan_binning.sav.** This is a hypothetical data file containing financial and demographic information on 5,000 past customers.

- **behavior.sav.** In a classic example, 52 students were asked to rate the combinations of 15 situations and 15 behaviors on a 10-point scale ranging from 0="extremely appropriate" to 9="extremely inappropriate." Averaged over individuals, the values are taken as dissimilarities.

- **behavior_ini.sav.** This data file contains an initial configuration for a two-dimensional solution for behavior.sav.

- **brakes.sav.** This is a hypothetical data file that concerns quality control at a factory that produces disc brakes for high-performance automobiles. The data file contains diameter measurements of 16 discs from each of 8 production machines. The target diameter for the brakes is 322 millimeters.

- **breakfast.sav.** In a classic study, 21 Wharton School MBA students and their spouses were asked to rank 15 breakfast items in order of preference with 1="most preferred" to 15="least preferred." Their preferences were recorded under six different scenarios, from “Overall preference” to “Snack, with beverage only.”

- **breakfast-overall.sav.** This data file contains the breakfast item preferences for the first scenario, “Overall preference,” only.

- **broadband_1.sav.** This is a hypothetical data file containing the number of subscribers, by region, to a national broadband service. The data file contains monthly subscriber numbers for 85 regions over a four-year period.

- **broadband_2.sav.** This data file is identical to broadband_1.sav but contains data for three additional months.

- **car_insurance_claims.sav.** A dataset presented and analyzed elsewhere concerns damage claims for cars. The average claim amount can be modeled as having a gamma distribution, using an inverse link function to relate the mean of the dependent variable to a linear combination of the policyholder age, vehicle type, and vehicle age. The number of claims filed can be used as a scaling weight.

- **car_sales.sav.** This data file contains hypothetical sales estimates, list prices, and physical specifications for various makes and models of vehicles. The list prices and physical specifications were obtained alternately from edmunds.com and manufacturer sites.

- **car_sales_uprepared.sav.** This is a modified version of car_sales.sav that does not include any transformed versions of the fields.

- **carpet.sav.** In a popular example, a company interested in marketing a new carpet cleaner wants to examine the influence of five factors on consumer preference—package design, brand name, price, a Good Housekeeping seal, and a money-back guarantee. There are three factor levels for package design, each one differing in the location of the applicator brush; three brand names (K2R, Glory, and Bissell); three price levels; and two levels (either no or yes) for each of the last two factors. Ten consumers rank 22 profiles defined by these factors. The variable Preference contains the rank of the average rankings for each profile. Low rankings correspond to high preference. This variable reflects an overall measure of preference for each profile.
Appendix A

- **carpet_prefs.sav.** This data file is based on the same example as described for *carpet.sav*, but it contains the actual rankings collected from each of the 10 consumers. The consumers were asked to rank the 22 product profiles from the most to the least preferred. The variables *PREF1* through *PREF22* contain the identifiers of the associated profiles, as defined in *carpet_plan.sav*.

- **catalog.sav.** This data file contains hypothetical monthly sales figures for three products sold by a catalog company. Data for five possible predictor variables are also included.

- **catalog_seasfac.sav.** This data file is the same as *catalog.sav* except for the addition of a set of seasonal factors calculated from the Seasonal Decomposition procedure along with the accompanying date variables.

- **cellular.sav.** This is a hypothetical data file that concerns a cellular phone company’s efforts to reduce churn. Churn propensity scores are applied to accounts, ranging from 0 to 100. Accounts scoring 50 or above may be looking to change providers.

- **ceramics.sav.** This is a hypothetical data file that concerns a manufacturer’s efforts to determine whether a new premium alloy has a greater heat resistance than a standard alloy. Each case represents a separate test of one of the alloys; the heat at which the bearing failed is recorded.

- **cereal.sav.** This is a hypothetical data file that concerns a poll of 880 people about their breakfast preferences, also noting their age, gender, marital status, and whether or not they have an active lifestyle (based on whether they exercise at least twice a week). Each case represents a separate respondent.

- **clothing_defects.sav.** This is a hypothetical data file that concerns the quality control process at a clothing factory. From each lot produced at the factory, the inspectors take a sample of clothes and count the number of clothes that are unacceptable.

- **coffee.sav.** This data file pertains to perceived images of six iced-coffee brands. For each of 23 iced-coffee image attributes, people selected all brands that were described by the attribute. The six brands are denoted AA, BB, CC, DD, EE, and FF to preserve confidentiality.

- **contacts.sav.** This is a hypothetical data file that concerns the contact lists for a group of corporate computer sales representatives. Each contact is categorized by the department of the company in which they work and their company ranks. Also recorded are the amount of the last sale made, the time since the last sale, and the size of the contact’s company.

- **creditpromo.sav.** This is a hypothetical data file that concerns a department store’s efforts to evaluate the effectiveness of a recent credit card promotion. To this end, 500 cardholders were randomly selected. Half received an ad promoting a reduced interest rate on purchases made over the next three months. Half received a standard seasonal ad.

- **customer_dbase.sav.** This is a hypothetical data file that concerns a company’s efforts to use the information in its data warehouse to make special offers to customers who are most likely to reply. A subset of the customer base was selected at random and given the special offers, and their responses were recorded.

- **customer_information.sav.** A hypothetical data file containing customer mailing information, such as name and address.

- **customer_subset.sav.** A subset of 80 cases from *customer_dbase.sav*. 
- **debate.sav.** This is a hypothetical data file that concerns paired responses to a survey from attendees of a political debate before and after the debate. Each case corresponds to a separate respondent.

- **debate_aggregate.sav.** This is a hypothetical data file that aggregates the responses in `debate.sav`. Each case corresponds to a cross-classification of preference before and after the debate.

- **demo.sav.** This is a hypothetical data file that concerns a purchased customer database, for the purpose of mailing monthly offers. Whether or not the customer responded to the offer is recorded, along with various demographic information.

- **demo_cs_1.sav.** This is a hypothetical data file that concerns the first step of a company’s efforts to compile a database of survey information. Each case corresponds to a different city, and the region, province, district, and city identification are recorded.

- **demo_cs_2.sav.** This is a hypothetical data file that concerns the second step of a company’s efforts to compile a database of survey information. Each case corresponds to a different household unit from cities selected in the first step, and the region, province, district, city, subdivision, and unit identification are recorded. The sampling information from the first two stages of the design is also included.

- **demo_cs.sav.** This is a hypothetical data file that contains survey information collected using a complex sampling design. Each case corresponds to a different household unit, and various demographic and sampling information is recorded.

- **dmdata.sav.** This is a hypothetical data file that contains demographic and purchasing information for a direct marketing company. `dmdata2.sav` contains information for a subset of contacts that received a test mailing, and `dmdata3.sav` contains information on the remaining contacts who did not receive the test mailing.

- **dietstudy.sav.** This hypothetical data file contains the results of a study of the “Stillman diet”. Each case corresponds to a separate subject and records his or her pre- and post-diet weights in pounds and triglyceride levels in mg/100 ml.

- **dvdplayer.sav.** This is a hypothetical data file that concerns the development of a new DVD player. Using a prototype, the marketing team has collected focus group data. Each case corresponds to a separate surveyed user and records some demographic information about them and their responses to questions about the prototype.

- **german_credit.sav.** This data file is taken from the “German credit” dataset in the Repository of Machine Learning Databases at the University of California, Irvine.

- **grocery_1month.sav.** This hypothetical data file is the `grocery_coupons.sav` data file with the weekly purchases “rolled-up” so that each case corresponds to a separate customer. Some of the variables that changed weekly disappear as a result, and the amount spent recorded is now the sum of the amounts spent during the four weeks of the study.

- **grocery_coupons.sav.** This is a hypothetical data file that contains survey data collected by a grocery store chain interested in the purchasing habits of their customers. Each customer is followed for four weeks, and each case corresponds to a separate customer-week and records information about where and how the customer shops, including how much was spent on groceries during that week.
Appendix A

- **guttman.sav.** Bell presented a table to illustrate possible social groups. Guttman used a portion of this table, in which five variables describing such things as social interaction, feelings of belonging to a group, physical proximity of members, and formality of the relationship were crossed with seven theoretical social groups, including crowds (for example, people at a football game), audiences (for example, people at a theater or classroom lecture), public (for example, newspaper or television audiences), mobs (like a crowd but with much more intense interaction), primary groups (intimate), secondary groups (voluntary), and the modern community (loose confederation resulting from close physical proximity and a need for specialized services).

- **health_funding.sav.** This is a hypothetical data file that contains data on health care funding (amount per 100 population), disease rates (rate per 10,000 population), and visits to health care providers (rate per 10,000 population). Each case represents a different city.

- **hivassay.sav.** This is a hypothetical data file that concerns the efforts of a pharmaceutical lab to develop a rapid assay for detecting HIV infection. The results of the assay are eight deepening shades of red, with deeper shades indicating greater likelihood of infection. A laboratory trial was conducted on 2,000 blood samples, half of which were infected with HIV and half of which were clean.

- **hourlywagedata.sav.** This is a hypothetical data file that concerns the hourly wages of nurses from office and hospital positions and with varying levels of experience.

- **insurance_claims.sav.** This is a hypothetical data file that concerns an insurance company that wants to build a model for flagging suspicious, potentially fraudulent claims. Each case represents a separate claim.

- **insure.sav.** This is a hypothetical data file that concerns an insurance company that is studying the risk factors that indicate whether a client will have to make a claim on a 10-year term life insurance contract. Each case in the data file represents a pair of contracts, one of which recorded a claim and the other didn’t, matched on age and gender.

- **judges.sav.** This is a hypothetical data file that concerns the scores given by trained judges (plus one enthusiast) to 300 gymnastics performances. Each row represents a separate performance; the judges viewed the same performances.

- **kinship_dat.sav.** Rosenberg and Kim set out to analyze 15 kinship terms (aunt, brother, cousin, daughter, father, granddaughter, grandfather, grandmother, grandson, mother, nephew, niece, sister, son, uncle). They asked four groups of college students (two female, two male) to sort these terms on the basis of similarities. Two groups (one female, one male) were asked to sort twice, with the second sorting based on a different criterion from the first sort. Thus, a total of six “sources” were obtained. Each source corresponds to a $15 \times 15$ proximity matrix, whose cells are equal to the number of people in a source minus the number of times the objects were partitioned together in that source.

- **kinship_ini.sav.** This data file contains an initial configuration for a three-dimensional solution for **kinship_dat.sav**.

- **kinship_var.sav.** This data file contains independent variables gender, generation, and degree (of separation) that can be used to interpret the dimensions of a solution for **kinship_dat.sav**. Specifically, they can be used to restrict the space of the solution to a linear combination of these variables.

- **marketvalues.sav.** This data file concerns home sales in a new housing development in Algonquin, Ill., during the years from 1999–2000. These sales are a matter of public record.
Sample Files


- **ozone.sav.** The data include 330 observations on six meteorological variables for predicting ozone concentration from the remaining variables. Previous researchers, among others found nonlinearities among these variables, which hinder standard regression approaches.

- **pain_medication.sav.** This hypothetical data file contains the results of a clinical trial for anti-inflammatory medication for treating chronic arthritic pain. Of particular interest is the time it takes for the drug to take effect and how it compares to an existing medication.

- **patient_los.sav.** This hypothetical data file contains the treatment records of patients who were admitted to the hospital for suspected myocardial infarction (MI, or “heart attack”). Each case corresponds to a separate patient and records many variables related to their hospital stay.

- **patlos_sample.sav.** This hypothetical data file contains the treatment records of a sample of patients who received thrombolytics during treatment for myocardial infarction (MI, or “heart attack”). Each case corresponds to a separate patient and records many variables related to their hospital stay.

- **poll_cs.sav.** This is a hypothetical data file that concerns pollsters’ efforts to determine the level of public support for a bill before the legislature. The cases correspond to registered voters. Each case records the county, township, and neighborhood in which the voter lives.

- **poll_cs_sample.sav.** This hypothetical data file contains a sample of the voters listed in poll_cs.sav. The sample was taken according to the design specified in the poll.csplan plan file, and this data file records the inclusion probabilities and sample weights. Note, however, that because the sampling plan makes use of a probability-proportional-to-size (PPS) method, there is also a file containing the joint selection probabilities (poll_jointprob.sav). The additional variables corresponding to voter demographics and their opinion on the proposed bill were collected and added to the data file after the sample was taken.

- **property_assess.sav.** This is a hypothetical data file that concerns a county assessor’s efforts to keep property value assessments up to date on limited resources. The cases correspond to properties sold in the county in the past year. Each case in the data file records the township in which the property lies, the assessor who last visited the property, the time since that assessment, the valuation made at that time, and the sale value of the property.

- **property_assess_cs.sav.** This is a hypothetical data file that concerns a state assessor’s efforts to keep property value assessments up to date on limited resources. The cases correspond to properties in the state. Each case in the data file records the county, township, and neighborhood in which the property lies, the time since the last assessment, and the valuation made at that time.

- **property_assess_cs_sample.sav.** This hypothetical data file contains a sample of the properties listed in property_assess_cs.sav. The sample was taken according to the design specified in the property_assess.csplan plan file, and this data file records the inclusion probabilities and sample weights. The additional variable Current value was collected and added to the data file after the sample was taken.
Appendix A

- **recidivism.sav.** This is a hypothetical data file that concerns a government law enforcement agency’s efforts to understand recidivism rates in their area of jurisdiction. Each case corresponds to a previous offender and records their demographic information, some details of their first crime, and then the time until their second arrest, if it occurred within two years of the first arrest.

- **recidivism_cs_sample.sav.** This is a hypothetical data file that concerns a government law enforcement agency’s efforts to understand recidivism rates in their area of jurisdiction. Each case corresponds to a previous offender, released from their first arrest during the month of June, 2003, and records their demographic information, some details of their first crime, and the data of their second arrest, if it occurred by the end of June, 2006. Offenders were selected from sampled departments according to the sampling plan specified in recidivism_cs.csplan; because it makes use of a probability-proportional-to-size (PPS) method, there is also a file containing the joint selection probabilities (recidivism_cs_jointprob.sav).

- **rfm_transactions.sav.** A hypothetical data file containing purchase transaction data, including date of purchase, item(s) purchased, and monetary amount of each transaction.

- **salesperformance.sav.** This is a hypothetical data file that concerns the evaluation of two new sales training courses. Sixty employees, divided into three groups, all receive standard training. In addition, group 2 gets technical training; group 3, a hands-on tutorial. Each employee was tested at the end of the training course and their score recorded. Each case in the data file represents a separate trainee and records the group to which they were assigned and the score they received on the exam.

- **satisf.sav.** This is a hypothetical data file that concerns a satisfaction survey conducted by a retail company at 4 store locations. 582 customers were surveyed in all, and each case represents the responses from a single customer.

- **screws.sav.** This data file contains information on the characteristics of screws, bolts, nuts, and tacks.

- **shampoo_ph.sav.** This is a hypothetical data file that concerns the quality control at a factory for hair products. At regular time intervals, six separate output batches are measured and their pH recorded. The target range is 4.5–5.5.

- **ships.sav.** A dataset presented and analyzed elsewhere that concerns damage to cargo ships caused by waves. The incident counts can be modeled as occurring at a Poisson rate given the ship type, construction period, and service period. The aggregate months of service for each cell of the table formed by the cross-classification of factors provides values for the exposure to risk.

- **site.sav.** This is a hypothetical data file that concerns a company’s efforts to choose new sites for their expanding business. They have hired two consultants to separately evaluate the sites, who, in addition to an extended report, summarized each site as a “good,” “fair,” or “poor” prospect.

- **smokers.sav.** This data file is abstracted from the 1998 National Household Survey of Drug Abuse and is a probability sample of American households. (http://dx.doi.org/10.3886/ICPSR02934) Thus, the first step in an analysis of this data file should be to weight the data to reflect population trends.

- **stroke_clean.sav.** This hypothetical data file contains the state of a medical database after it has been cleaned using procedures in the Data Preparation option.
- **stroke_invalid.sav.** This hypothetical data file contains the initial state of a medical database and contains several data entry errors.

- **stroke_survival.** This hypothetical data file concerns survival times for patients exiting a rehabilitation program post-ischemic stroke face a number of challenges. Post-stroke, the occurrence of myocardial infarction, ischemic stroke, or hemorrhagic stroke is noted and the time of the event recorded. The sample is left-truncated because it only includes patients who survived through the end of the rehabilitation program administered post-stroke.

- **stroke_valid.sav.** This hypothetical data file contains the state of a medical database after the values have been checked using the Validate Data procedure. It still contains potentially anomalous cases.

- **survey_sample.sav.** This data file contains survey data, including demographic data and various attitude measures. It is based on a subset of variables from the 1998 NORC General Social Survey, although some data values have been modified and additional fictitious variables have been added for demonstration purposes.

- **telco.sav.** This is a hypothetical data file that concerns a telecommunications company’s efforts to reduce churn in their customer base. Each case corresponds to a separate customer and records various demographic and service usage information.

- **telco_extra.sav.** This data file is similar to the telco.sav data file, but the “tenure” and log-transformed customer spending variables have been removed and replaced by standardized log-transformed customer spending variables.

- **telco_missing.sav.** This data file is a subset of the telco.sav data file, but some of the demographic data values have been replaced with missing values.

- **testmarket.sav.** This hypothetical data file concerns a fast food chain’s plans to add a new item to its menu. There are three possible campaigns for promoting the new product, so the new item is introduced at locations in several randomly selected markets. A different promotion is used at each location, and the weekly sales of the new item are recorded for the first four weeks. Each case corresponds to a separate location-week.

- **testmarket_1month.sav.** This hypothetical data file is the testmarket.sav data file with the weekly sales “rolled-up” so that each case corresponds to a separate location. Some of the variables that changed weekly disappear as a result, and the sales recorded is now the sum of the sales during the four weeks of the study.

- **tree_car.sav.** This is a hypothetical data file containing demographic and vehicle purchase price data.

- **tree_credit.sav.** This is a hypothetical data file containing demographic and bank loan history data.

- **tree_missing_data.sav** This is a hypothetical data file containing demographic and bank loan history data with a large number of missing values.

- **tree_score_car.sav.** This is a hypothetical data file containing demographic and vehicle purchase price data.

- **tree_textdata.sav.** A simple data file with only two variables intended primarily to show the default state of variables prior to assignment of measurement level and value labels.
Appendix A

- **tv-survey.sav.** This is a hypothetical data file that concerns a survey conducted by a TV studio that is considering whether to extend the run of a successful program. 906 respondents were asked whether they would watch the program under various conditions. Each row represents a separate respondent; each column is a separate condition.

- **ulcer_recurrence.sav.** This file contains partial information from a study designed to compare the efficacy of two therapies for preventing the recurrence of ulcers. It provides a good example of interval-censored data and has been presented and analyzed elsewhere.

- **ulcer_recurrence_recoded.sav.** This file reorganizes the information in ulcer_recurrence.sav to allow you model the event probability for each interval of the study rather than simply the end-of-study event probability. It has been presented and analyzed elsewhere.

- **verd1985.sav.** This data file concerns a survey. The responses of 15 subjects to 8 variables were recorded. The variables of interest are divided into three sets. Set 1 includes age and marital, set 2 includes pet and news, and set 3 includes music and live. Pet is scaled as multiple nominal and age is scaled as ordinal; all of the other variables are scaled as single nominal.

- **virus.sav.** This is a hypothetical data file that concerns the efforts of an Internet service provider (ISP) to determine the effects of a virus on its networks. They have tracked the (approximate) percentage of infected e-mail traffic on its networks over time, from the moment of discovery until the threat was contained.

- **wheeze_steubenville.sav.** This is a subset from a longitudinal study of the health effects of air pollution on children. The data contain repeated binary measures of the wheezing status for children from Steubenville, Ohio, at ages 7, 8, 9 and 10 years, along with a fixed recording of whether or not the mother was a smoker during the first year of the study.

- **workprog.sav.** This is a hypothetical data file that concerns a government works program that tries to place disadvantaged people into better jobs. A sample of potential program participants were followed, some of whom were randomly selected for enrollment in the program, while others were not. Each case represents a separate program participant.
Notices


Patent No. 7,023,453

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: SPSS INC., AN IBM COMPANY, PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. SPSS Inc. may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-SPSS and non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this SPSS Inc. product and use of those Web sites is at your own risk.

When you send information to IBM or SPSS, you grant IBM and SPSS a nonexclusive right to use or distribute the information in any way it believes appropriate without incurring any obligation to you.

Information concerning non-SPSS products was obtained from the suppliers of those products, their published announcements or other publicly available sources. SPSS has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-SPSS products. Questions on the capabilities of non-SPSS products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to SPSS Inc., for the purposes of developing,
using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. SPSS Inc., therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided “AS IS”, without warranty of any kind. SPSS Inc. shall not be liable for any damages arising out of your use of the sample programs.

**Trademarks**


SPSS is a trademark of SPSS Inc., an IBM Company, registered in many jurisdictions worldwide.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or other countries.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.


Other product and service names might be trademarks of IBM, SPSS, or other companies.

Adobe product screenshot(s) reprinted with permission from Adobe Systems Incorporated.

Microsoft product screenshot(s) reprinted with permission from Microsoft Corporation.
CHAID, 1
   Bonferroni adjustment, 10
   intervals for scale independent variables, 11
   maximum iterations, 10
   resplitting merged categories, 10
   splitting and merging criteria, 10
classification table, 67
collapsing tree branches, 37
command syntax
   creating selection and scoring syntax for decision trees, 35, 44
costs
   misclassification, 16
   tree models, 72
crossvalidation
   trees, 7
CRT, 1
   impurity measures, 12
   pruning, 14
decision trees, 1
   CHAID method, 1
   CRT method, 1
   Exhaustive CHAID method, 1
   forcing first variable into model, 1
   measurement level, 1
   QUEST method, 1, 13
gain, 65
gains chart, 66
Gini, 12
hiding nodes
   vs. pruning, 14
hiding tree branches, 37
impurity
   CRT trees, 12
index
   tree models, 65
index chart, 66
index values
   trees, 26
legal notices, 105
measurement level
decision trees, 1
   in tree models, 48
misclassification
   costs, 16
   rates, 67
   trees, 26
missing values
   in tree models, 86
   trees, 21
model summary table
tree models, 62
node number
   saving as variable from decision trees, 22
nodes
   selecting multiple tree nodes, 37
ordered twoing, 12
predicted probability
   saving as variable from decision trees, 22
predicted values
   saving as variable from decision trees, 22
   saving for tree models, 68
profits
   prior probability, 18
   trees, 17, 26
   pruning decision trees
   vs. hiding nodes, 14
   QUEST, 1, 13
   pruning, 14
random number seed
decision tree validation, 7
response
tree models, 65
risk estimates
   for categorical dependent variables, 67
   for scale dependent variables in Decision Tree procedure, 81
   trees, 26
rules
   creating selection and scoring syntax for decision trees, 35, 44
sample files
   location, 96
scale variables
dependent variables in Decision Tree procedure, 77
   scores
   trees, 20
scoring

tree models, 77
selecting multiple tree nodes, 37
significance level for splitting nodes, 13
split-sample validation
trees, 7
SQL
creating SQL syntax for selection and scoring, 35, 44
surrogates
in tree models, 86, 93
syntax
creating selection and scoring syntax for decision trees, 35, 44

trademarks, 106
tree models, 65
trees, 1
applying models, 77
CHAID growing criteria, 10
charts, 29
colors, 42
controlling node size, 9
controlling tree display, 24, 41
crossvalidation, 7
CRT method, 12
custom costs, 72
editing, 37
effects of measurement level, 48
effects of value labels, 52
fonts, 42
gains for nodes table, 65
generating rules, 35, 44
hiding branches and nodes, 37
index values, 26
intervals for scale independent variables, 11
limiting number of levels, 9
misclassification costs, 16
misclassification table, 26
missing values, 21, 86
model summary table, 62
node chart colors, 42
predictor importance, 26
prior probability, 18
profits, 17
pruning, 14
risk estimates, 26
risk estimates for scale dependent variables, 81
saving model variables, 22
saving predicted values, 68
scale dependent variables, 77
scaling tree display, 39
scores, 20
scoring, 77
selecting cases in nodes, 69
selecting multiple nodes, 37
showing and hiding branch statistics, 24
split-sample validation, 7
surrogates, 86, 93
terminal node statistics, 26
text attributes, 42
tree contents in a table, 24
tree in table format, 64
tree map, 39
tree orientation, 24
working with large trees, 38
twoing, 12
validation
trees, 7
value labels
trees, 52
weighting cases
fractional weights in decision trees, 1